**Table of Contents**

**NURBS Modeling** .......................................................... 1

**Viewports** ................................................................. 2
  - Viewport Title Menu .................................................. 2
  - Viewport Display Modes .......................................... 2
  - Mouse Navigation ....................................................... 3
  - Viewport Projection .................................................. 3

**Modeling Aids** ............................................................. 4
  - Cursor Crosshairs, Marker, and Tracking Line .................. 4
  - Grid Snap .................................................................. 4
  - Ortho Mode ............................................................. 4
  - Distance Constraint .................................................. 5
  - Angle Constraint ...................................................... 5
  - Elevator Mode .......................................................... 5

**Coordinate Systems** ................................................... 7
  - Cartesian Coordinates .............................................. 7
  - World Coordinates ................................................... 7
  - Construction Planes .................................................. 7
  - Relative Coordinates ............................................... 8

**Object Snaps** .............................................................. 10
  - Persistent Object Snaps ............................................ 10
  - SmartTrack .............................................................. 11

**Rhino’s Geometry Types** ............................................. 12
  - Point Objects .......................................................... 12
  - Curves ..................................................................... 12
  - Surfaces ................................................................... 12
  - Polysurfaces ............................................................ 15
  - Solids ....................................................................... 15
  - Polygon Mesh Objects .............................................. 16

**Edit Curves and Surfaces** ........................................... 17
  - Join .......................................................................... 17
  - Explode ................................................................. 17
  - Trim and Split .......................................................... 17
  - Control-Point Editing ................................................ 17
  - Curve and Surface Degree ........................................ 18

**Transforms** ................................................................. 19
  - Move ........................................................................ 19
  - Copy ........................................................................ 19
  - Rotate ................................................................. 19
  - Scale ....................................................................... 19
  - Mirror ................................................................. 19
  - Orient ................................................................. 19
  - Array ..................................................................... 19
# Curve and Surface Analysis .................................................................20
  Measure Distance, Angle, and Radius.................................................. 20
  Curve and Surface Direction ............................................................... 20
  Curvature ............................................................................................ 20
  Visual Surface Analysis ...................................................................... 21
  Edge Evaluation .................................................................................. 22
  Diagnostics ...................................................................................... 22

# Organizing the Model ........................................................................23
  Layers .................................................................................................. 23
  Groups ................................................................................................ 23
  Blocks ................................................................................................ 23
  Worksessions ..................................................................................... 24

# Annotation ..........................................................................................25
  Dimensions ........................................................................................ 25
  Text ................................................................................................... 25
  Leaders .............................................................................................. 25
  Annotation Dots ................................................................................ 26
  Hidden Line Removal ......................................................................... 26
  Notes .................................................................................................. 26

# Render ..................................................................................................27
  Lights ................................................................................................ 27
  Render Mesh ...................................................................................... 27

# Tutorial: Solids and Transforms ..........................................................28
  Enter Coordinates ............................................................................. 28
  Draw the Pull Toy Body .................................................................... 28
  Draw the Axles and Wheel Hubs ...................................................... 29
  Draw the Lug Nuts .......................................................................... 30
  Assign Colors .................................................................................. 32
  Array the Lug Nuts .......................................................................... 32
  Draw the Tires .................................................................................. 33
  Mirror the Wheels .......................................................................... 33
  Draw the Eyes .................................................................................. 35
  Make the Pull Cord .......................................................................... 36

# Tutorial: Revolve Curves .................................................................39
  Create a Free-Form Flashlight Model ................................................ 39
  Set Up the Model ............................................................................. 39
  Draw a Centerline ........................................................................... 40
  Draw the Body Profile Curve ........................................................... 40
  Draw the Lens Profile Curve ............................................................ 41
  Build the Flashlight Body ............................................................... 41
  Create the Lens ............................................................................... 42
  Assign Properties and Render .......................................................... 42
Tutorial: Sweep, Loft, and Extrude .............................................................44
  Create the Speaker Shell ......................................................................... 44
  Extrude a Curve into a Solid .................................................................... 45
  Join the Surfaces Together ...................................................................... 47
  Create the Padding .................................................................................. 47
  Create the Mounting Bracket .................................................................. 48
  Create the Headband ............................................................................... 48
  Create the Speaker Wire .......................................................................... 50
  Mirror the Headphone Parts ..................................................................... 56

Tutorial: Point Editing and Blend Surfaces ..................................................58
  Create the Body and Head ...................................................................... 58
  Create and Place the Eyes ....................................................................... 61
  Create the Beak ..................................................................................... 62
  Create the Feet ...................................................................................... 64
  Create the Tail ...................................................................................... 67
  Create the Wings ................................................................................... 69
  Finishing Touches .................................................................................. 71
  Apply Render Materials .......................................................................... 72

Tutorial: Loft a Boat Hull ............................................................................73
  Lay Out the Hull Curves ......................................................................... 73
  Check for Fairness .................................................................................. 74
  Create the 3-D Curves .......................................................................... 75
  About the Curves ................................................................................... 76
  Loft the Hull Surfaces .......................................................................... 76
  Trim the Bow and Bottom ...................................................................... 77
  Build the Transom ................................................................................ 78
  Complete the Transom .......................................................................... 80
  Add the Deck ........................................................................................ 80

Tutorial: Trace Images ............................................................................... 84
  Draw the Body ....................................................................................... 84
  Draw the Head ...................................................................................... 87
  Blend the Head and Body ....................................................................... 88
  Draw the Eyes ....................................................................................... 89
  Shape the Tail ...................................................................................... 90
  Trace the Wings and Legs ..................................................................... 90

Tutorial: Wrap Curves on a Surface ............................................................92
  Make a Surface ..................................................................................... 92
  Create the Objects to Wrap ................................................................... 93
  Control the Placement of the Objects .................................................... 93

Tutorial: Blends and Trims .........................................................................96
  Create Basic Body Shape ....................................................................... 98
  Blend the Front and Back Edges ............................................................. 100
  Trim the Body for the Viewfinder ........................................................... 103
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create the Viewfinder</td>
<td>105</td>
</tr>
<tr>
<td>Blend between the Body and the Viewfinder</td>
<td>107</td>
</tr>
<tr>
<td>Create Bottom of Camera</td>
<td>108</td>
</tr>
<tr>
<td>Create the Lens and Blend between the Body and the Lens</td>
<td>110</td>
</tr>
<tr>
<td><strong>More Help</strong></td>
<td><strong>113</strong></td>
</tr>
<tr>
<td>Help on the Internet</td>
<td>113</td>
</tr>
</tbody>
</table>
NURBS Modeling

NURBS (non-uniform rational B-splines) are mathematical representations that can accurately model any shape from a simple 2-D line, circle, arc, or box to the most complex 3-D free-form organic surface or solid. Because of their flexibility and accuracy, NURBS models can be used in any process from illustration and animation to manufacturing.

NURBS geometry is an industry standard for designers who work in 3-D where forms are free and flowing; where both form and function is important. Rhino is used in marine, aerospace, and automobile interior and exterior design. Makers of household and office appliances, furniture, medical and sports equipment, footwear, and jewelry use Rhino to create free-form shapes.

NURBS modeling is also widely used by professional animators and graphic artists. The advantage over using polygon modelers is that there are no facets. The models can be rendered at any resolution. A mesh can be created from the model at any resolution. For more information about the mathematics of NURBS, see the Rhino Help topic.
Viewports

The viewport title has some special functions for manipulating the viewport.
- Click the title to make the viewport active without disturbing the view.
- Drag the viewport title to move the viewport.
- Double-click the viewport title to maximize the viewport. Double-click again to restore the size to normal.

Viewport Title Menu

Right-click any viewport title to display a menu. From this menu, pan, rotate, zoom, set one of the standard views, set a construction plane, set the camera and target locations, choose a shading option, set the grid, and set other viewport properties.

Viewport Display Modes

Wireframe display usually offers the fastest display speed. Standard and customized shaded modes allow easier visualization of surfaces and solids.

Wireframe Display

In wireframe view, surfaces look like a set of crossing curves. These curves are called *isoparametric curves* or *isocurves*.
Isocurves do not define the surface the way the polygons do in a polygon mesh. They are merely a visual aid.
The *WireframeViewport* command sets the viewport display to wireframe.

Shaded Display

Shaded modes display surfaces and solids with the surfaces shaded using their layer, object, or custom color. You can work in any of the shaded modes. The surfaces are opaque or transparent.
The *ShadedViewport* command sets the viewport display to shaded mode.
**Rendered Display**

Rendered viewport display shows the objects with lighting and render materials applied.

The **RenderedViewport** command sets the viewport display to rendered mode.

Other display modes and custom settings are described in the Rhino Help.

---

**Mouse Navigation**

Working in 3-D on a computer requires visualizing three-dimensional objects drawn on a two-dimensional medium—the computer screen. Rhino provides tools to help do this.

Drag with the right mouse button to easily manipulate the views to look at the model from various angles. Use the right mouse button view manipulations in both wireframe and shaded views.

---

**Viewport Projection**

Viewports can have one of two projections: parallel or perspective.

Right mouse navigation works differently in the two viewport styles. In parallel views, right-mouse dragging pans the view. In perspective views, right-mouse dragging rotates the view.

In the usual four-viewport layout, there are three parallel viewports and one perspective viewport.

**Parallel**

Parallel views are also called orthogonal views in some systems. In a parallel view, all the grid lines are parallel to each other, and identical objects look the same size, regardless of where they are in space.

** Perspective**

In a perspective view, grid lines converge to a vanishing point. This provides the illusion of depth in the viewport. Perspective projection makes objects farther away look smaller.
Modeling Aids

The cursor can always move freely in space, but chances are, you will want to relate your modeling elements to the construction plane grid or to existing objects. You can restrict the cursor’s movement to the grid, enter specific distances and angles from a point, and snap to specific locations on existing objects.

Cursor Crosshairs, Marker, and Tracking Line

There are two parts of the cursor: the cursor (1) and the marker (2). The cursor always follow the mouse movement. The marker sometimes leaves the center of the cursor because of some constraint on it such as grid snap or ortho. The marker is a dynamic preview of the point that will be picked when the left mouse button is clicked.

When the marker is constrained, in elevator mode, for example, a tracking line (3) also displays. Constraints move your marker to a specific point in space or make its movement track according to the constraint so you can model accurately.

Grid Snap

Grid snap constrains the marker to an imaginary grid that extends infinitely. You can set the snap spacing to any value. Click the Snap button on the status bar to turn grid snap on and off.

Ortho Mode

Ortho mode constrains the marker movement or object dragging to a specific set of angles. By default, this is parallel to the grid lines, but you can change this. Ortho is similar to the axis lock function found in drawing or animation programs. Click the Ortho pane on the status bar to turn ortho on and off. Press and hold the Shift key to temporarily toggle the ortho mode.

Another common use for ortho is to constrain object dragging to a specific axis. Ortho is active after the first point for a command. For example, after picking the first point for a line, the second point is constrained to the ortho angle.

If you only need a different angle for a single operation, angle constraint is faster to use. Enter a specific angle for one operation instead of changing the ortho angle and then changing it back.
**Distance Constraint**

When entering points, you can constrain the marker to a distance from the previous point. Once you have set the distance, drag the line around to any angle. You can also use further snaps to point the line in a specific direction.

During any command that requires two points, such as the Line command, place the first point. Then at the next prompt, type a distance and press Enter or the Spacebar.

The marker will be constrained to the specified distance from the previous point. Drag the cursor around the first point and then pick a point.

You can also constrain the marker to track on lines radiating from the previous point and separated by a specified angle. The first constraint line is counterclockwise from the construction plane x-axis.

**Angle Constraint**

Angle constraint is similar to ortho, but you can set any angle and it is a one-time setting.

The < symbol is used because it is similar to the ∠ symbol used in geometry to indicate an angle.

The marker will be constrained to lines radiating from the previous point separated by the specified angle, where the first line is the specified number of degrees counterclockwise from the x-axis. If you enter a negative number, the angle will be clockwise from the x-axis.

**Distance and Angle Together**

Distance and angle constraints can be used at the same time. Type the distance at the prompt and press Enter, and then type < and then the angle and press Enter. The order of the distance and angle does not matter. The marker will drag around your original point at angle increments at the specified distance.

**Elevator Mode**

To move the marker in the construction plane z-direction, hold the Ctrl key and click a point on the construction plane, and then drag vertically from the construction plane and click to pick a point. This constraint is called elevator mode. Using elevator mode to move your pick point vertically from the construction plane lets you work more in the Perspective viewport.
Pick a second point to specify the z-coordinate of the desired point. It is easiest to see this in a different viewport or use the Perspective viewport. Drag the mouse cursor around to see the marker move vertically from the base point along the tracking line.

Pick the point with the mouse or type the height above the construction plane. Positive numbers are above the construction plane; negative numbers are below it. You can use further constraints like coordinates, object snaps or grid snap for the first point, and you can use object snaps for the height.
Coordinate Systems
Rhino uses two coordinate systems: construction plane coordinates and world coordinates. World coordinates are fixed in space. Construction plane coordinates are defined for each viewport.

Cartesian Coordinates
When Rhino prompts you for a point, if you type x and y Cartesian coordinates, the point will lie on the construction plane of the current viewport. For more information about coordinate systems and numeric constraints, see the Rhino Help topic, “Unit Systems.”

Right-Hand Rule
Rhino follows what is called the right-hand rule. The right-hand rule can help you determine the direction of the z-axis. Form a right angle with the thumb and forefinger of your right hand. When your thumb points in the positive x-direction, your forefinger points in the positive y-direction, and the palm of your hand faces in the positive z-direction.

World Coordinates
Rhino contains one world coordinate system. The world coordinate system cannot be changed. When Rhino prompts you for a point, you can type coordinates in the world coordinate system. The arrow icon in the lower left corner of each viewport displays the direction of the world x-, y-, and z-axes. The arrows move to show the orientation of the world axes when you rotate a view.

Construction Planes
Each viewport has a construction plane. A construction plane is like a tabletop that the cursor moves on unless you use coordinate input, elevator mode, or object snaps or a few other instances where input is constrained. The construction plane has an origin, x- and y-axes, and a grid. The construction plane can be set to any orientation. By default, each viewport’s construction plane is independent of those in other viewports. The construction plane represents the local coordinate system for the viewport and can be different from the world coordinate system.

Rhino’s standard viewports come with construction planes that correspond to the viewport. The default Perspective viewport, however, uses the world Top construction plane, which is the same construction plane that is used in the Top viewport.

The grid lies on the construction plane. The dark red line represents the construction plane x-axis. The dark green line represents the construction plane y-axis. The red and green lines meet at the construction plane origin.
To change the direction and origin of a construction plane, use the **CPlane** command. Preset construction planes (World Top, Right, and Front) give you quick access to common construction planes. In addition, you can save and restore named construction planes and import named construction planes from another Rhino file.

### 2-D construction plane coordinates
- At a prompt, type the coordinate in the format \( x,y \) where \( x \) is the x-coordinate and \( y \) is the y-coordinate of the point.

![A line from 1,1 to 4,2.](image)

### 3-D construction plane coordinates
- At a prompt, type the coordinate in the format \( x,y,z \) where \( x \) is the x-coordinate, \( y \) is the y-coordinate, and \( z \) is the z-coordinate of the point.
  - There are no spaces between the coordinate values.
  - To place a point 3 units in the x-direction, 4 units in the y-direction, and 10 units in the z-direction from the construction plane origin, type \( 3,4,10 \) at the prompt.

**Note**  If you enter only x- and y-coordinates, the point will lie on the construction plane.

### Relative Coordinates
Rhino remembers the last point used, so you can enter the next point relative to it. Relative coordinates are useful for entering a list of points where the relative locations instead of absolute locations of the points are known. Use relative coordinates to locate points according to their relationship to the previous active point.

**Relative coordinates**
- At a prompt, type the coordinates in the format \( rx,y \) where \( r \) signifies that the coordinate is relative to the previous point.

**For example**
1. Start the **Line** command.
2. At the **Start of line...** prompt, click to place the first end of the line.
3 At the **End of line...** prompt, type `r2,3`, and press **Enter** or the **Spacebar**.

The line is drawn to a point 2 units in the x-direction and 3 units in the y-direction from the last point.
Object Snaps

Object snaps constrain the marker to specific points on an object. When Rhino asks you to specify a point, you can constrain the marker to specific parts of existing geometry. When an object snap is active, moving the cursor near a specified point on an object causes the marker to jump to that point.

In this chapter you will learn:

• How to use object snaps to find specific points on geometry.
• How to set, clear, and suspend persistent object snaps.
• How to use one-time object snaps.
• How to use object snaps in combination with other modeling aids.

Object snaps can persist from pick to pick, or can be activated for one pick only. Multiple persistent object snaps can be set from the status bar. All object snaps behave similarly, but snap to different parts of existing geometry. In addition, there are special object snaps that work for one pick only.

Persistent Object Snaps

Use persistent objects snaps to maintain an object snap through choosing several points. Since persistent object snaps are easy to turn on and off, you can set them and leave them on until they get in your way. You can then set a different one or just disable them.

Sometimes object snaps interfere with each other and with grid snap or ortho. Object snaps normally take precedence over grid snap or other constraints.

There are other situations where object snaps work in conjunction with other constraints. You will see examples of this in this chapter. For more information including video demonstrations, see the Help topic “Object Snaps.”

To turn persistent object snaps on and off
1. On the status bar, click the Osnap pane.
2. In the Osnap toolbar, check or clear the desired object snaps.

To suspend all persistent object snaps
   In the Osnap toolbar, click the Disable button.
   All persistent object snaps will be suspended, but remain checked.

To clear all persistent object snaps
   In the Osnap toolbar, click the Disable button with the right mouse button.
   All persistent object snaps will be cleared.

To turn on one object snap and turn all others off with one click
In the Osnap toolbar, right-click the object snap you want to turn on.
SmartTrack

SmartTrack™ is a system of temporary reference lines and points that is drawn in the Rhino viewport using implicit relationships among various 3-D points, other geometry in space, and the coordinate axes’ directions.

Temporary infinite lines (tracking lines) and points (smart points) are available to object snaps very much like real lines and points.

You can snap to intersections of the tracking lines, perpendiculares, and directly to smart points as well as intersections of tracking lines and real curves. The tracking lines and smart points are displayed for the duration of a command.

For more information including video demonstrations, see the Help topic “SmartTrack.”
Rhino’s Geometry Types

Rhino’s geometry types include: points, NURBS curves, polylines, surfaces, polysurfaces, solids (closed surfaces), and polygon meshes. Surfaces and polysurfaces that enclose a volume define solids. Rhino creates polygon meshes for rendering, surface analysis, and for importing and exporting models to other applications.

Point Objects

Point objects mark a single point in 3-D space. They are the simplest objects in Rhino. Points can be placed anywhere in space. Points are most often used as placeholders.

Curves

A Rhino curve is similar to a piece of wire. It can be straight or wiggled, and can be open or closed.

A *polycurve* is several curve segments joined together end to end.

Rhino provides many tools for drawing curves. You can draw straight lines, polylines that consist of connected line segments, arcs, circles, polygons, ellipses, helixes, and spirals.

You can also draw curves using curve control points and draw curves that pass through selected points.

Curves in Rhino include lines, arcs, circles, free-form curves, and combinations of these. Curves can be open or closed, planar or non-planar.

Surfaces

A surface is like a rectangular stretchy rubber sheet. The NURBS form can represent simple shapes, such as planes and cylinders, as well as free-form, sculptured surfaces.

All surface creation commands in Rhino result in the same object: a NURBS surface. Rhino has many tools for constructing surfaces directly or from existing curves.
All NURBS surfaces have an inherently rectangular organization. Even a closed surface such as a cylinder is like a rectangular piece of paper that has been rolled up so two opposite edges are touching. The place where the edges come together is called the *seam*. If a surface does not have a rectangular shape, either it has been trimmed or the control points on the edges have been moved.

**Closed and Open Surfaces**

A surface can be open or closed. A cylinder without the ends capped is closed in one direction.

A torus (donut shape) is closed in two directions.

**Surface Control Points**

The shape of a surface is defined by a set of control points that are arranged in a rectangular pattern.

**Trimmed and Untrimmed Surfaces**

Surfaces can be trimmed or untrimmed. A trimmed surface has two parts: a surface that underlies everything and defines the geometric shape, and trimming curves that mark sections of the underlying surface that are removed from view.

Trimmed surfaces are created with commands that trim or split surfaces with curves and other surfaces. Some commands create trimmed surfaces directly.

Since it can be important for you to know if a surface is trimmed, the *Properties* command lists the trimmed or untrimmed state of the surface. Some Rhino commands work only with untrimmed surfaces and some software does not import trimmed NURBS surfaces.
Trimming curves lie on the underlying surface. This surface may be larger than the trim curves, but you will not see the underlying surface because Rhino does not draw the part of the surface that is outside the trim curves. Every trimmed surface retains information about its underlying surface geometry. You can remove the trimming curve boundaries to make the surface untrimmed with the `Untrim` command.

If you have a trim curve that runs across a surface, the trim curve itself does not have any real relationship to the control point structure of the surface. You can see this if you select such a trimmed surface and turn its control points on. You will see the control points for the whole underlying surface.

If you create a surface from a planar curve, it can be a trimmed surface. The illustrated surface was created from a circle. The control points display shows the rectangular structure of the surface.

The `Untrim` command removes the trimming curve from the surface to get back to the underlying untrimmed rectangular surface.
Surface Isoparametric and Edge Curves

In wireframe view, surfaces look like a set of crossing curves. These curves are called *isoparametric curves* or *isocurves*. These curves help you visualize the shape of the surface. Isoparametric curves do not define the surface the way the polygons do in a polygon mesh. They are merely a visual aid that allows you to see the surface on the screen. When a surface is selected, all of its isoparametric curves highlight.

Edge curves bound the surface. Surface edge curves can be used as input to other commands.

Polysurfaces

A polysurface consists of two or more surfaces that are joined together. A polysurface that encloses a volume of space defines a solid. Control points cannot be displayed on polysurfaces, but the polysurfaces can be exploded into surfaces, which can be edited separately, and then rejoined.

Solids

A solid is a surface or polysurface that encloses a volume. Solids are created anytime a surface or polysurface is completely closed. Rhino creates single-surface solids and polysurface solids. A single surface can wrap around and join itself (sphere, torus, and ellipsoid). Control points can be displayed on single-surface solids and moved to change the surface.

Some Rhino commands for creating solid primitives create polysurface solids. Box, cone, truncated cone, and cylinder are examples of polysurface solids.
Polygon Mesh Objects

Because there are many modelers that use polygon meshes to represent geometry for rendering and animation, stereolithography, visualization, and finite element analysis, the Mesh command translates NURBS geometry into polygonal meshes for export. In addition, the Mesh creation commands draw mesh objects.

Note: There is no easy way to convert a mesh model into a NURBS model. The information that defines the objects is completely different. However, Rhino has a few commands for drawing curves on meshes and extracting vertex points and other information from mesh objects to assist in using mesh information to create NURBS models.
Edit Curves and Surfaces

The editing operations in this section break objects apart, cut holes in them, and put them back together. Some of these commands connect curves to curves or surfaces to surfaces or polysurfaces and break a composite curve or polysurface into its components.

The commands: **Join**, **Explode**, **Trim**, and **Split** apply to curves, surfaces, and polysurfaces.

The **Rebuild**, **ChangeDegree**, and **Smooth** commands alter the shape of a curve or surface by changing its underlying control point structure.

In addition, objects have properties that are assigned to them such as color, layer, rendering material, and other attributes depending on the object. The **Properties** command manages these properties.

**Join**

The **Join** command connects curves or surfaces together into one object. For example, a polyline can consist of straight-line segments, arcs, polylines, and free-form curves. The **Join** command also connects adjacent surfaces into a polysurface.

**Explode**

The **Explode** command removes the connection between joined curves or surfaces. For polysurfaces, this is useful if you want to edit each individual surface with control points.

**Trim and Split**

The **Trim** and **Split** commands are similar. The difference is when you trim an object, you select the parts to remove and they are deleted. When you split an object, all parts are left.

The **Split** command will split a surface with a curve, surface, polysurface, or its own isoparametric curves.

The **Untrim** command removes a surface’s trimming curve, with an option to keep the curve so you can re-use it.

**Control-Point Editing**

You can make subtle changes in the shape of a curve or surface by moving the location of its control points. Rhino offers many tools for editing control points. Some commands such as **Rebuild**, **Fair**, and **Smooth** offer some automated solutions for redistributing control points over a curve or surface. Other commands, such as control point dragging and nudging, **HBar**, and **MoveUVNOn**, let you manually control the location of individual or groups of control points.

**Control Point Visibility**

To edit curves and surfaces by manipulating control points, use the **PointsOn** (**F10**) command to turn the control points on.

When you are finished with control-point editing, use the **PointsOff** command or press **Esc** to turn them off.

Control points of polysurfaces cannot be turned on for editing. Editing the control points of polysurfaces could separate the edges of the joined surfaces creating “leaks” in the polysurface.

**Change Control Points Locations**

When you move control points, the curve or surface changes, and Rhino smoothly redraws it. The curve or surface is not drawn though the control points rather it is attracted to the new positions of the control point. This allows the object to be smoothly deformed. When control points are on, Rhino’s transform commands can manipulate the points. You can also rebuild surfaces to add control points and redistribute them.
Add, Delete, or Redistribute Control Points

Adding control points to a curve gives you more control over the shape of the curve. Manipulating control points also lets you remove kinks, make curves uniform, and add or subtract detail. The Delete key erases curve control points. This changes the shape of the curve.

Curve and Surface Degree

A polynomial is a function like \( y = 3 \cdot x^3 - 2 \cdot x + 1 \). The "degree" of the polynomial is the largest power of the variable. For example, the degree of \( 3 \cdot x^3 - 2 \cdot x + 1 \) is 3; the degree of \( -x^5 + x^2 \) is 5, and so on. NURBS functions are rational polynomials and the degree of the NURBS is the degree of the polynomial. From a NURBS modeling point of view, the (degree – 1) is the maximum number of "bends" you can get in each span.

For example:

A degree-1 curve must have at least two control points.
A line has degree 1. It has zero "bends."

A degree-2 curve must have at least three control points.
A parabola, hyperbola, arc, and circle (conic section curves) have degree 2. They have one "bend."

A degree-3 curve must have at least four control points.
A cubic Bézier has degree 3. If you arrange its control points in a zig-zag shape, you can get two "bends."
Transforms

Transforms change the location, rotation, number and shape of whole objects by moving, mirroring, arraying, rotating, scaling, shearing, twisting, bending, and tapering. The transform commands do not break the objects into pieces or cut holes in them.

For more information and animated demonstrations, see the Help topic for each command.

**Move**

Use the **Move** command when you want to move an object a certain distance or if you want to use object snaps to place an object accurately. The quickest way is to click the object and drag it.

To move selected objects small distances, press and hold the **Alt** key and press an arrow key to activate the **Nudge** feature.

**Copy**

The **Copy** command makes copies of objects.

Some transform commands like **Rotate**, **Rotate 3-D**, and **Scale** have a **Copy** option. This lets you create a copy of the object as you rotate or scale it.

To copy objects by dragging, hold the **Alt** key and then drag the objects.

**Rotate**

The **Rotate** command rotates an object in relation to the construction plane.

**Scale**

Scale commands give you control over the direction of the scale. You can resize objects uniformly in one, two, or three directions, or scale an object with a different scale factor in each direction.

**Mirror**

The **Mirror** command reverses the orientation of the object across a defined line. By default, a copy is made.

**Orient**

The orient commands combine move or copy, scale, and rotate operations to help you position and size objects in one command.

**Array**

Copies objects into evenly spaced rows and columns.
Curve and Surface Analysis
Since Rhino is a mathematically accurate NURBS modeler, tools that provide accurate information about the objects are provided.

Measure Distance, Angle, and Radius
Some analysis commands provide information about location, distance, angle between lines, and radius of a curve. For example:
- **Distance** displays the distance between two points.
- **Angle** displays the angle between two lines.
- **Radius** displays the radius of a curve at any point along it.
- **Length** displays the length of a curve.
- **EvaluatePt** displays coordinate information for any point.

Curve and Surface Direction
Curves and surfaces have a **direction**. Many commands that use direction information display direction arrows and give you the opportunity to change (flip) the direction.

The **Dir** command displays the direction of a curve or surface and lets you change the direction.

The illustration shows the curve direction arrows. If the direction has not been changed, it reflects the direction the curve was originally drawn. The arrows point from the start of the curve toward the end of the curve.

The **Dir** command also displays surface u-, v-, and normal direction. Surface normals are represented by arrows perpendicular to the surface, and the u- and v-directions are indicated by arrows pointing along the surface. Closed surfaces always have the surface normals pointing to the exterior.

The **Dir** command can change the u-, v-, and normal-directions of a surface. This direction can be important if you are applying textures to the surface.

Curvature
Curve analysis tools let you turn on a graph showing the direction perpendicular to the curve at a point and the amount of curvature, display a curvature circle, test the continuity between two curves and the intervals of overlap between the two curves.
The **CurvatureGraphOn** command displays a curvature graph on curves and surfaces. The lines on the graph represent a direction perpendicular to the curve at that point. The length of the line indicates the curvature.

**Visual Surface Analysis**

Visual surface analysis commands let you examine surfaces to determine smoothness as determined by its curvature, tangency, or other surface properties. These commands use NURBS surface evaluation and rendering techniques to help you visually analyze surface smoothness with false color or reflection maps so you can see the curvature and breaks in the surface.

The **CurvatureAnalysis** command analyzes surface curvature using false-color mapping. It analyzes Gaussian curvature, mean curvature, minimum radius of curvature, and maximum radius of curvature.

The **EMap** command displays a bitmap on the object so it looks like a scene is being reflected by a highly polished metal. Tool helps you find surface defects and validate your design intent.

The fluorescent tube environment map simulates tube lights shining on a reflective metal surface.

The **Zebra** command displays surfaces with reflected stripes. This is a way to visually check for surface defects and for tangency and curvature continuity conditions between surfaces.
The **DraftAngleAnalysis** command displays by false-color mapping the draft angle relative to the construction plane that is active when you start the command.

The pull direction for the **DraftAngleAnalysis** command is the z-axis of the construction plane.

**Edge Evaluation**

Geometry problems such as Boolean or join failures can be caused by edges on surfaces that have become broken or edges between surfaces that have been moved through point editing so they create holes. An *edge* is a separate object that is part of the surface's boundary representation.

The **ShowEdges** command highlights all the edges of the surface.

**Find the Open Edges on a Polysurface**

A polysurface may look closed, but the **Properties** command may tell you that it is open. Some operations and export features require closed polysurfaces, and a model using closed polysurfaces is generally higher quality than one with small cracks and slivers.

Rhino provides a tool for finding the unjoined or "naked" edges. When a surface is not joined to another surface, it has naked edges. Use **Properties** command to examine the object details. A polysurface that has naked edges lists as an *open polysurface*. Use the **ShowEdges** command to display the unjoined edges.

Other edge tools let you split an edge, merge edges that meet end-to-end, or force surfaces with naked edges to join. You can rebuild edges based on internal tolerances. Other edge tools include:

- **SplitEdge** splits an edge at a point.
- **MergeEdge** merges edges that meet end to end.
- **JoinEdge** forces unjoined (naked) edges to join nearby surfaces.
- **RebuildEdges** redistributes edge control points based on internal tolerances.

**Diagnostics**

Diagnostic tools report on an object’s internal data structure and select objects that may need repair. The output from the **List**, **Check**, **SelBadObjects**, and **Audit3dmFile** commands is normally most useful to a Rhino programmer to diagnose problems with surfaces that are causing errors.
Organizing the Model

Rhino offers aids to organizing your work: layers, groups, blocks, and worksessions. Each method offers a different approach to model organization. Using layers lets you assign a layer designation to objects. Groups associate objects so they can be selected as one. Blocks let you store and update an association of objects. Worksessions let you work on a part of a project while using other models in the project as references.

Layers

Layers are a way of grouping objects and applying certain characteristics to all objects that have that layer assignment. There are two “mental models” you can use when you think of layers—layers can be thought of either as a “storage location” for the objects or as a way to assign a set of characteristics or properties to objects.

Layer states include a layer name, the color used to display the objects, and the on/off and locked/unlocked status of all the objects on a layer. Objects on layers that are off are not visible in the model. Objects on locked layers cannot be selected but can be snapped to. Objects are always created on the current layer. This layer assignment can be changed later.

To accomplish the most common tasks related to layers, click the Layer pane in the status bar to display the popup layer list. You can set the current layer; change the on/off, locked/unlocked state; and the layer color. In addition, right-click the layer name to create a new layer, rename a layer, delete the selected layer, select objects on the selected layer, change objects to the selected layer, and copy objects to the selected layer.

Accomplish more detailed layer management with the Layers window. Right-click the Layer pane to open the Layers window. The Layers window sets the current layer, locks and unlocks layers, turns layers on and off, changes the layer color and sets the layer render material. You can create new layers, delete layers, move layers up or down in the layer list, filter the layer list, set the current layer to match an object in the model, change objects to a selected layer, select all layers, and invert the selection.

The SelLayer command selects all objects on a layer.

Groups

A group is a collection of objects that select as one for moving, copying, rotating, or other transforms and applying properties such as object color. Grouping objects assigns a group name to each object that is displayed as a part of its properties. Objects with the same group name belong to the same group.

- **Group** groups objects for selection. A group can contain one or more sub-groups.
- **Ungroup** destroys the group.
- **SetGroupName** changes the name assigned by default. Naming different groups to the same name combines those groups into one.
- **AddToGroup** and **RemoveFromGroup** add and remove objects from groups.
- **SelGroup** selects groups by name.

Blocks

A block is another way of associating objects together to form a single object. The Block command creates a block definition in the current model. The Insert command places instances of this block definition in your model. You can scale, copy, rotate, array, and otherwise transform block instances in the model. If you redefine the block definition, all instances of the block are changed to this new definition. Blocks can streamline modeling, reduce model size, and promote standardization of parts and details.

Multiple instances of block can be located, scaled, and rotated into a model with the Insert command. Block definitions are created with the Block or Insert command. Materials and other object properties on block instances are determined by the component objects.
Exploding a block instance places the block geometry using the instance location, scale, and rotation. To redefine a block, use the **Explode** command to return the block instance to its original geometry, edit the geometry, and define the block again with the **Block** command using the same block name.

The **BlockManager** command displays a dialog box that lists all the block definitions in the model. Use the **Block Manager** dialog box to view block properties, export a block definition to a file, delete a block definition and all its instances, update a block definition from a file, find out what blocks are nested in other blocks, and count the number of block instances in the model.

**Worksessions**

The **Worksession** command lets many users work on a large project by managing many files. Each user can edit a different file in the project and at the same time see the related portions of the project. By refreshing as needed, each user can see the current version of the related files in the projects. Only one user can have a file open for editing, but many users can see it.

Rhino worksessions let you “attach” external files to your current work environment. Attached geometry cannot be edited (move, scale), but it can be used for input to creation commands (copy, extrude).
Annotation

Rhino provides the ability to add notation to your model in the form of dimensions, leaders, and text blocks. These appear as objects in the model. A different form of notation, the annotation dots and arrowheads, always display facing towards the view plane.

In addition, you can add notes to the model. Notes do not appear in the model, but display in a separate window.

Dimensions

You can dimension objects in your model, with your choice of font, units display, decimal precision, text and arrow size, and text alignment. After dimensions are placed, you can select all dimensions, edit dimension text, turn control points on to move dimension elements, and delete dimensions. You can place horizontal, vertical, aligned, rotated, radial, diameter, and angle, text blocks, leaders, and create a 2-D hidden line drawing.

Dimensions are not associative. Changing your geometry will not update the dimension; likewise, changing the dimension will not update your geometry.

The Dim command places horizontal and vertical dimensions depending on the direction you pick the points.

Dimensions are created using the current dimension style. Create new dimension styles to control text size and font, and other dimension properties. Use the settings in the Document Properties dialog box to create new styles and set the properties of existing styles.

Text

The Text command places annotation text in your model.

Leaders

The Leader command draws an arrow leader.
Annotation Dots

The **Dot** command places a text dot. Dots are always parallel to the view. There are no controls for the dot size. Dots are displayed in the layer color. Dot size is constant on the screen. As you zoom in and out, the dot displays the same size.

Hidden Line Removal

The **Make2D** command creates curves from the selected objects as silhouettes relative to the active view. The silhouette curves are projected flat and then placed on the world x,y-plane. The command options create the 2-D drawing from the current view, current construction plane, create a four-view layout using US or European projection angles, set layers for the hidden lines, and display tangent edges.

Notes

The **Notes** command provides a means of storing text information in your model file. You can type information directly into the **Notes** text box. If you leave the **Notes** box displayed when you close the model file, it will display the next time the file is opened.
Render

In addition to shaded previews, Rhino provides full-color rendering with lights, transparency, shadows, textures, and bump mapping. If you want to create photo-realistic renderings, use a full-featured rendering program, such as Flamingo.

Objects will render white until you add render color, highlight, texture, transparency, and bumps. These attributes are controlled through the Properties window, Material page.

Lights

In every Rhino rendering there are light sources that Rhino uses to calculate how the objects are to be illuminated. If you do not add any light sources to your scene, the default light is used. The default light is a directional light with parallel rays that acts as though you have a lamp shining over your left shoulder.

Render Mesh

When you shade or render your model, Rhino automatically generates a polygon mesh for each surface. These meshes are not visible in wireframe view mode, but are only used for rendering and shading. These meshes are saved and will be used the next time you render unless you change the model. This makes rendering much faster after the first time.

Render meshes can considerably increase the size of your model file. If you would like to save file space, the Save Small checkbox on the Save dialog box delete the saved mesh from the model.

Jagged Objects

A possible problem with rendering is jagged-looking objects that should be smooth. This is because Rhino generates polygon meshes from all NURBS objects into before rendering. Depending on the shape of the objects, the default mesh settings may not create enough polygons, which can make the individual polygons distinguishable, and since the polygons are flat, they look jagged.

In the Document Properties dialog box, on the Mesh page, under Render mesh quality click Smooth & slower, or you can use a Custom option.
Tutorial: Solids and Transforms

This tutorial demonstrates using solid primitives and simple transforms.
You will learn how to:
- Enter coordinates to place points exactly.
- Draw a free-form curve and polygon.
- Create a pipe along a curve.
- Use a polar array to copy objects in a circular pattern.
- Extrude a curve to create a surface.
- Use planar mode.

Enter Coordinates

When you pick a point with the mouse, the point lies on the construction plane of the active viewport unless you use a modeling aid such as object snap or elevator mode. When Rhino prompts for a point, you can enter x-, y-, and z-coordinates instead of picking a point. Each viewport has its own construction plane on which its x- and y-coordinates lie. The z-coordinate for the active viewport is perpendicular to the x-y plane.

The grid is a visual representation of the construction plane. The intersection of the dark red and green lines shows the location of the origin point (x=0, y=0, z=0) of the coordinate system.

Draw the Pull Toy Body

This exercise uses x-, y-, and z-coordinates to accurately place points. When you are to type coordinates, type them just as they are shown in the manual. The format is x,y,z. For example, type 1,1,4. You must type the commas. This sets the point at x=1, y=1, and z=4 in the active viewport.

Whenever you type points, look in all viewports at where the point is placed so you can start getting an idea of how coordinate entry works.

Note  Pay close attention to the viewport required in each instruction.

Start the model

1 Begin a new model.
2 In the Template File dialog box, select Small Objects - Centimeters.3dm, and click Open.

Draw an ellipsoid

1 Turn on Ortho.
2 From the Solid menu, click Ellipsoid > From Center.
3 With the Top viewport active, at the Ellipsoid center... prompt, type 0,0,11 and press Enter.
   This places the center point of the ellipsoid at x=0, y=0, and z=11. Look at the point in the perspective viewport.
4 At the End of first axis... prompt, type 15 and press Enter.
5 Move the cursor to the right to show the direction and click.

6 At the End of second axis prompt, type 8 and press Enter.
7 Move the cursor up to show the direction and click.
   This sets the width of the ellipsoid.

8 At the Pick point prompt, type 9 and press Enter.
   You now have an egg shape that has different dimensions in all three directions.

Rotate the perspective viewport so you are looking along the x-axis as illustrated.
   Turn on Shaded Viewport display in the Perspective viewport.

**Draw the Axles and Wheel Hubs**
The axles and wheel hubs are cylinders. The axles are long, thin cylinders, and the wheel hubs are short, fat cylinders. You are going to make one axle and one complete wheel. You will then mirror the complete wheel to the other side. You can then either mirror or copy the complete axle and wheel set to the front of the toy.
Create the axle

1. From the Solid menu, click Cylinder.
2. With the Front viewport active, at the Base of cylinder... prompt, type 9,6.5,10 and press Enter.
3. At the Radius... prompt, type .5 and press Enter.
4. At the End of cylinder prompt, type -20 and press Enter.

Create a wheel hub

1. From the Solid menu, click Cylinder.
2. With the Front viewport active, at the Base of cylinder... prompt, type 9,6.5,10 and press Enter.
3. At the Radius... prompt, type 4 and press Enter.
4. At the End of cylinder prompt, type 2, and press Enter.

Draw the Lug Nuts
You will make the lug nuts by extruding a hexagonal polygon curve.

Create a hexagon

1. From the Curve menu, click Polygon > Center, Radius.
2. At the Center of inscribed polygon (NumSides=4...) prompt, type 6 and press Enter.
3. In the Front viewport, at the Center of inscribed polygon... prompt, type 9,8,12 and press Enter.
   This will place the polygon right on the surface of the wheel hub.
4. At the Corner of polygon... prompt, type .5 and press Enter.
5 In the **Front** viewport drag the cursor as illustrated, and click to position the hexagon.

Make a solid from the polygon

1 Select the hexagon you just created.
2 From the **Solid** menu, click **Extrude Planar Curve > Straight**.
3 At the **Extrusion distance (Direction BothSides=No Cap=Yes Mode=Straight)** prompt, notice the command options.
   Many commands have options. You will learn how to change and use them as you learn to use the commands. Take a moment and look at the options available for the **ExtrudeCrv** command.
   Press **F1** to look at the Help topic for this command. The Help topic explains the options.
4 At the **Extrusion Distance...** prompt, type **-.5** and press **Enter**.
   Notice the negative number. If you type a positive number at this point, the nuts will be buried in the wheel hub. You want them to stick out.
Assign Colors

Now that you have the basic parts built, you are going to assign colors to them before we start copying them. If we wait until we have all the parts, you will have to select 20 lug nuts separately. If we assign colors now, the color property will be copied when we copy the parts.

Assign color to the parts

1. Select the lug nut.
2. From the Edit menu, click Object Properties.
3. In the Properties window, switch to Material properties.
4. In the Properties window, on the Material page, under Assign by, click Basic, and then click the color swatch.
5. In the Select Color dialog box, under Named Colors, click Black, and then click OK.
6. Select the toy body and repeat steps 4 through 6.
   You will be assigning colors to objects as we go along.
7. Render the Perspective viewport.

Array the Lug Nuts

To create the lug nuts on the first wheel, you are going to use a polar (circular) array. An array is a set of copies of an object. You control how the copies are made. A polar array copies the objects around a central point. The objects are rotated as they are copied.

Array the nuts

1. Select the lug nut.
2. From the Transform menu, click Array, and then click Polar.
The hexagon curve is still there, so be sure you select the extruded lug nut. (The selection menu will list it as a *polysurface.*)

3 With the **Front** viewport active, at the **Center of polar array** prompt, use the **Cen** object snap to snap to the center of the hub.

4 At the **Number of elements...** prompt, type 5 and press **Enter**.

5 At the **Angle to fill <360>** prompt, press **Enter**.

**Draw the Tires**

The tires are a solid form called a torus, which looks like a donut. When you are drawing a torus, the first radius is the radius of a circle around which the “tube” is drawn. The second radius is the radius of the tube itself.

To draw the tires, you will draw the center of the torus tube a bit larger than the diameter of the wheel hub. The tube itself is slightly larger than the hub. This makes it dip into the hub.

**Create a torus for the tires**

1 From the **Solid** menu, click **Torus**.

2 In the **Front** viewport, at the **Center of torus...** prompt, type 9,6.5,11 and press **Enter**.

   This places the center of the torus at the same point as the center of the wheel hub.

3 At the **Radius...** prompt, type 5 and press **Enter**.

   This makes the center of the torus tube one unit larger than the wheel hub.

4 At the **Second radius...** prompt, type 1.5 and press **Enter**.

   This makes the hole .5 units smaller than the wheel hub.

5 Set the **Color** of the tire to **Black** and the **Gloss finish** to about 40.

6 **Render** the **Perspective** viewport.

**Mirror the Wheels**

Now that you have a whole wheel created, you can use the **Mirror** command to create the other three.
Mirror the wheel to the other side

1. In the Top viewport, use a window to select the wheel as illustrated.
2. From the Transform menu, click Mirror.
3. At the Start of mirror plane... prompt, type 0,0,0 and press Enter.
4. At the End of mirror plane... prompt, with Ortho on, drag to the right in the Top viewport as illustrated and click.

Mirror the front wheels and axle

1. In the Top viewport, use a window to select the wheels and axle as illustrated.
2. From the Transform menu, click Mirror.
3. At the Start of mirror plane... prompt, type 0,0,0 and press Enter.
4. At the End of mirror plane... prompt, with Ortho on, drag down in the Top viewport as illustrated and click.
Draw the Eyes

You are going to draw a sphere for an eye and a smaller sphere for the pupil.

Create an eye
1. From the Solid menu, click Sphere, and then click Center, Radius.
2. At the Center of sphere... prompt, in the Top viewport, type -12,-3,14 and press Enter.
3. At the Radius... prompt, type 3 and press Enter.
4. Repeat the Sphere command.
5. At the Center of sphere... prompt, in the Top viewport, type -13,-4,15 and press Enter.
6. At the Radius... prompt, type 2 and press Enter.
7. Change the color of the pupil to black.

Mirror the eye
1. In the Top viewport, use a window to select the eye as illustrated.
2. From the Transform menu, click Mirror.
3. At the Start of mirror plane... prompt, type 0,0,0 and press Enter.
4. At the End of mirror plane... prompt, with Ortho on, drag to the left in the Top viewport as illustrated and click.
5  Right-click the **Perspective** viewport title.
6  From the **Viewport title** menu, click **Rendered**.

**Make the Pull Cord**

To make the cord, you are going to draw a freehand curve using elevator and planar mode. When the curve is complete, use the **Pipe** command to make it a thick solid.

**Create the pull cord at the front of the toy**

1  Zoom out in all the viewports; you are going to need some space to work.
2  On the status bar, turn **Planar** mode on, and turn **Ortho** off.
3  In the **Osnap** dialog box, click **Disable** to turn off all object snaps.
4  From the **Curve** menu, click **Free-form**, and then click **Control Points**.
5  At the **Start of curve**... prompt, in the **Top** viewport, hold Ctrl to activate elevator mode and click near the front end of the ellipsoid.
6  Move the cursor to the **Front** viewport, drag the marker near the end of the ellipsoid, and click.

7  At the **Next point**... prompt, click to the left of the ellipsoid in the **Top** viewport.
Planar mode keeps successive points at the same construction plane elevation. Planar mode can be overridden with elevator mode or object snaps. Watch the curve in the Top and Front viewports.

8 At the Next point... prompt, use elevator mode to add another point in the Top viewport.

9 At Next point... prompts, turn off Planar mode and click several more points in the Top viewport to create a curved line.

Notice that the points are projected to the Top construction plane.

10 Draw an Ellipsoid to represent a handle at the end of the curve.

In the Osnap dialog box, clear the Disable checkbox and use the End object snap to snap the ellipsoid to the end of the curve.
Make the cord fat

1. Select the curve you just made at the front of the pull toy.
2. From the Solid menu, click Pipe.
3. At the Start radius... prompt, type .2 and press Enter.
4. At the End radius... prompt, press Enter.
5. At the Point for next radius prompt, press Enter.
   The pipe will be the same diameter for the full length of the curve.
7. Render the Perspective viewport.
Tutorial: Revolve Curves

Drawing objects using solid primitives, as you have done in the previous exercises, limits the shapes you can create. Creating surfaces from curves and joining the surfaces together allows you much greater freedom.

This tutorial introduces the concept of drawing curves and one method of creating surfaces from those curves. This exercise creates a revolved surface from a profile curve. Revolving curves is a good method for creating tubular shapes like vases, wineglasses, and chair legs.

You will learn how to:
- Draw free-form curves based on an existing object.
- Edit control points.
- Revolve surfaces around an axis.
- Assign properties and render.

Create a Free-Form Flashlight Model

If you have not already done so, work through the "Flashlight" tutorial you will find in the Rhino Help, Getting Started Tutorials. This tutorial emphasizes using solid polysurfaces and Booleans to create a mechanical shape. To try this tutorial, from the Rhino Help table of contents, click Getting Started, and then click the Flashlight link.

You are going to use the flashlight from that tutorial as a guide for drawing the curves you will need for the new model. Using the old flashlight gives you a frame of reference for deciding about the size and shape of the object. If you did not work through this tutorial or save your model, a completed model is provided.

To get started

1. On the Rhino Help menu, click Learn Rhino, and then click Open Tutorial Models.
2. Open the model file Flashlight.3dm.

Set Up the Model

You are going to trace around the old flashlight. To make this easier, you will lock the objects. When objects are locked, you can see them and snap to them, but you cannot select them. This keeps the objects from interfering when you want to select things close by. You can still use object snaps to snap to locked objects. You will then create some curves and revolve them to make the new flashlight.

Lock the flashlight objects

1. Select all the objects.
   Press Ctrl + A to select all the objects in the model.
2. From the Edit menu, click Visibility, and then click Lock.
Draw a Centerline

Draw a construction centerline through the center of the old flashlight.

**Draw the construction centerline**

1. From the Curve menu, click Line, and then click Single Line.
2. At the Start of line... prompt, use the Center object snap to place the start of the line at the center of the flashlight base.
3. At the End of line... prompt, turn Ortho on, and draw the line through the exact center of the old flashlight.

Draw the Body Profile Curve

You are going to draw a profile curve that you will use to revolve to create the flashlight body. A profile curve defines a cross-section of one half of the part.

**Draw the body curve**

1. On the status bar, click the Layer pane and make the layer Free Form Body current.
2. From the Curve menu, click Free-Form, and then click Control Points.
3. At the Start of curve... prompt, in the Front viewport, start drawing a curve around the flashlight body as illustrated.

Use the End object snap to start the curve at the end of the construction centerline.

Use the Near object snap to end the curve on the construction centerline.

Starting and ending the curve exactly on the line is important so that later when you revolve the curve to create a solid, there will be no gaps or overlapping parts.

When drawing the curve, use Ortho to control the first two points on the curve. If the first two points and the last two points are placed in a straight line, the curve will start and end tangent to that line.
When you have placed the last control point, press Enter to finish drawing the curve. To place the last two points in a straight line with each other, use grid snap, Ortho, or Perp object snap.

**Draw the Lens Profile Curve**

Make another profile curve for the lens.

**Create the lens**

1. From the Curve menu, click Free-Form, and then click Control Points.
2. At the Start of curve... prompt, in the Front viewport, place the first control point of the lens profile.
   Use the Near object snap to start and end the curve on the construction centerline.
   Place control points in the upper part of the lens curve so it crosses the body profile curve.

**Get the old flashlight out of your way**

1. From the Edit menu, click Visibility, and then click Unlock.
2. Select all the objects except the two profile curves you just drew and the switch sphere.
3. From the Edit menu, click Visibility, and then click Hide.

**Build the Flashlight Body**

To make the body, you will revolve the profile curve 360 degrees. You will use the endpoint of the curve and ortho to establish the rotation axis.

**Create the flashlight body**

1. From the Surface menu, click Revolve.
2. At the Select curve to revolve prompt, select the body profile curve.
3. At the Start of revolve axis prompt, snap to one endpoint of the body curve.
4. At the End of revolve axis prompt, turn Ortho on, and specify the revolve axis line as illustrated.
5 In the **Start angle...** prompt, click the **FullCircle** option.

---

**Create the Lens**

Now revolve the lens profile curve in the same way as the body.

**Revolve the lens profile curve**

1 From the **Surface** menu, click **Revolve**.

2 At the **Select curve to revolve** prompt, select the lens profile curve.

3 At the **Start of revolve axis** prompt, use **End** object snap to locate the endpoint of one of the curve profiles.

4 At the **End of revolve axis** prompt, turn **Ortho** on, and draw the revolve axis line as illustrated.

5 In the **Start angle...** prompt, click the **FullCircle** option.

---

**Assign Properties and Render**

Assign object properties to the body and lens and render. In illustration, the body is red with a small highlight; the lens is about 50% transparent.
Assign object properties and render

1. Draw a Plane under the flashlight to provide an object to receive shadows.
2. From the Edit menu, click Object Properties, and select the Material window.
3. Set the properties for each of the flashlight parts.
4. Render the Perspective viewport.
Tutorial: Sweep, Loft, and Extrude

This tutorial demonstrates creating surfaces from profile curves using lofts, sweeps, and extrudes.

You will learn how to:

- Create a surface from a planar curve.
- Loft, revolve, sweep, and extrude surfaces.
- Cap planar holes to create a solid.
- Create solid pipes.
- Mirror objects.
- Use layers.
- Use object snaps.

A model is provided as a starting point. If you have not completed the Getting Started tutorials in the Rhino Help, try them first.

To open the headphone model

1. On the Rhino Help menu, click Learn Rhino, and then click Open Tutorial Models.
2. Open the model file Headphone.3dm.

Create the Speaker Shell

The speaker shell is created using a lofted surface, a one-rail sweep, a solid extrusion of a planar curve, and a surface fillet. The resulting geometry is joined into one solid.

Loft Curves to Create a Surface

One way to create a surface is to use existing curves as a guide. When you loft through curves, the curves are used as a guide for creating a smooth surface.

Make a surface by lofting curves

1. Turn on ShadedViewport in the Perspective viewport.
2. Select the three circular curves, with a crossing selection as illustrated.
3. From the Surface menu, click Loft.
4. At the Adjust curve seams... prompt, note the display of the curve direction arrows at the seam points, and press Enter
   In this model, they are nicely lined up for you, so you do not need to adjust them.
In the **Loft Options** dialog box, click **OK** to create the loft.

**Extrude a Curve into a Solid**

You are going to extrude the curve in the center to make a magnet housing.

**To make a solid cylinder by extruding a circular curve**

1. Select the curve at the center of the lofted surface.
2. From the **Solid** menu, click **Extrude Planar Curve > Straight**.

3. At the **Extrusion Distance...** prompt, type `-2` and press **Enter**.
   This makes a solid cylinder for the magnet housing that is two units thick and extends in the negative direction from the original curve.

**Zoom in on the cylinder**

1. Select the cylinder.
2. From the **View** menu, click **Zoom**, and then click **Zoom Selected**.
   The cylinder you just created is a closed polysurface (solid) consisting of three joined surfaces—the side, top, and bottom. To remove the bottom, extract the face.
3. From the **Solid** menu, click **Extract Surface**.
4 At the **Select surfaces to extract...** prompt, select the surface as illustrated and press **Enter**.

5 Press the **Delete** key.

---

**Fillet the edge of the cylinder surface**

1 From the **Solid** menu, click **Fillet Edge > Fillet Edge**.

   The current radius setting should be 1.

2 At the **Select edges to fillet...** prompt, select the edge at the top of the cylinder press **Enter**.

3 At the **Select fillet handle to edit** prompt, press **Enter**.
Join the Surfaces Together
Surfaces that share an edge can be joined into a polysurface. You will join all the surfaces. Since the faces are sometimes hard to see, use two viewports to select them all.

To join the surfaces
1. Select the surface and the polysurface.
2. From the Edit menu, click Join.
To join surfaces, you must select surfaces that are adjacent to each other and the edges must match.

Create the Padding
To create the padding around the edge of the speaker you will sweep a curve around the edge of the speaker cone.

Sweep a curve along one rail
1. From the View menu, click Zoom, and then click Zoom Extents All.
2. Select the curves as illustrated.
3. From the Surface menu, click Sweep 1 Rail.

4. In the Sweep 1 Rail Options dialog box, click OK.
Create the Speaker Cone Cover
You are going to fill the area at the base of the padding with a planar surface created from the edge of the sweep.

Make a surface from planar curves
1. From the Surface menu, click From Planar Curves.
2. Select the curve on the edge of the speaker cone as illustrated.

Create the Mounting Bracket
The next part is the bracket that holds the speaker to the headband. Since the speaker unit is complete, you can turn its layer off and make the Bracket layer current.

To reset the layers and view
1. On the status bar, click the Layer pane.
2. Make Bracket the current layer and turn on Bracket Shape Curves.
   Turn all other layers off.
3. From the View menu, click Zoom, and then click Zoom Extents All to zoom in on the bracket shape curves in all viewports.

Create a Solid by Extruding a Curve
You can use a planar curve to create a solid shape
To extrude a curve into a solid

1. Select the closed curve.
2. From the Solid menu, click Extrude Planar Curve > Straight.

3. At the Extrusion distance... prompt, type -1 and press Enter.

Fillet the Edges to Smooth Them
You can round the sharp edges with a fillet.

Fillet the edges

1. From the Solid menu, click Fillet Edge > Fillet Edge.
2. At the Select edges to fillet... prompt, type .2 and press Enter.
3. At the Select edges to fillet... prompt, select both edges and press Enter.

4. At the Select fillet handle to edit prompt, press Enter.
Create the Mounting Pins
You can create the mounting pins with the Pipe command.

To create a tubular surfaces from the shape curves
1. Select the curve at the top of the bracket.
2. From the Solid menu, click Pipe.
3. At the Starting radius... prompt, type .3 and press Enter.
   Before typing the radius, make sure the options are set to Cap=Flat and Thick=No.
4. At the End radius... prompt, press Enter.
5. At the Point for next radius prompt, press Enter.
6. Select the curve at the bottom of the bracket.
7. From the Solid menu, click Pipe.

8. At the Starting radius... prompt, type .2 and press Enter.
9. At the End radius... prompt, press Enter.
10. At the Point for next radius prompt, press Enter.

Create the Headband
The headband consists of a series of ellipses swept along a path.

Reset the layers and view
1. On the status bar, click the Layer pane.
2. Make Headband the current layer and turn on Headband Shape Curves.
   Turn all other layers off.
3. From the View menu, click Zoom, and then click Zoom Extents All to zoom in on
   the headband shape curves in all viewports.
Create an ellipse perpendicular to a curve

1. Turn Ortho on.
2. From the Curve menu, click Ellipse, and then click From Center.
3. At the Ellipse center... prompt, click AroundCurve.

4. At the Ellipse center prompt, snap to an endpoint of the headband curve. Use the End object snap.
5. At the End of first axis prompt, type 0.5 and press Enter.
6. At the End of first axis prompt, drag the cursor in the x-direction and click.

7. At the End of second axis prompt, type 2, and press Enter.
8. At the End of second axis prompt, drag the cursor in the y-direction and click.

Array a curve along a path

1. Select the ellipse.
2. From the Transform menu, click Array, and then click Along Curve.
3. At the Select path curve prompt, select headband curve.
4 In the Array Along Curve Options dialog box, under Method, set the Number of items to 3.

5 Under Orientation, click Freeform and click OK.

Scale the Ellipse
In the next step, scale the center ellipse to make it larger.

Scale the ellipse
1 Select the center ellipse.
2 From the Transform menu, click Scale, and then click Scale1-D. Scale1D stretches an object in one direction.
3 At the Origin point... prompt, in the Perspective viewport, snap to the center of selected ellipse.
4 At the Scale factor or first reference point... prompt, type 2, and press Enter.
5 At the Second reference point... prompt, drag the cursor in the y-direction and click.

Sweep along one rail
1 From the View menu, click Zoom, and then click Extents All.
2 Select the curves.
3 From the Surface menu, click Sweep 1 Rail.
At the Adjust curve seams... prompt, examine the direction and seam points of the curves to make sure they are not twisted, and press Enter.

In the Sweep 1 Rail Options dialog box, click OK.

Create a Rounded Shape at the Ends of the Headband
Using the same ellipse that formed the first cross-section curve for the headband, create a rounded end for the headband. To create the surface that will be joined to the headband, split the ellipse in half.

Split the ellipse in half
1. From the View menu, click Zoom, and then click Window.
2. In the Perspective viewport, zoom in on the left end of the headband you just created.
3. Turn on Quad object snap.
4. Select the ellipse.
5. From the Edit menu, click Split.

6. At the Select cutting objects... prompt, type P, and press Enter.
7. At the Point to split curve prompts, snap to the two quadrants at the narrow axis of the ellipse.
8. At the Point to split curve prompt, press Enter.
   The ellipse is split into two halves.

Create a surface of revolution
1. Select left half of the ellipse.
2. From the Surface menu, click Revolve.
3  At the **Start of revolve axis** prompt, snap to the end of the ellipse half.
4  At the **End of revolve axis** prompt, snap to the other end of the ellipse half.
5  At the **Start angle...** prompt, type **0**, press **Enter**.
6  At the **Revolution angle...** prompt, type **180**, press **Enter**.
   A rounded surface is created at the end of the headband.
7  Repeat these steps for the other side of the headband.

**Join the surfaces**
1  Select the surfaces.
2  From the **Edit** menu, click **Join**.
   Three surfaces joined into one polysurface.

**Create the Speaker Wire**
Use a separate layer to create the speaker wire.

**Reset the layers and view**
1  On the status bar, click the **Layer** pane.
2  Make **Wire Shape Curves** the current layer and turn on **Wire**.
   Turn all other layers off.
3  From the **View** menu, click **Zoom**, and then click **Zoom Extents All** to zoom in on the wire shape curves in all viewports.

**Make the helix**
1  From the **Curve** menu, click **Helix**.
2  At the **Start of axis...** prompt, click **AroundCurve**.
3  At the **Select curve** prompt, select the long free-form curve.
4 At the **Radius and start point...** prompt, type **1** and press **Enter**.
This sets the radius for the helix.

5 At the **Radius and start point...** prompt, set **Turns=30**, and **NumPointsPerTurn=8**.

6 At the **Radius and start point...** prompt, in the **Right** viewport drag the cursor to the left and click.

**Match and join the helix to the end curves**

1 From the **View** menu, click **Zoom**, and then click **Window**.

2 In the **Perspective** viewport, zoom in on the left end of the helix you just created.

3 From the **Curve** menu, click **Curve Edit Tools**, and then click **Match**.

4 At the **Select open curve to change - pick near end** prompt, select near the left end of the helix.

5 At the **Select open curve to match - pick near end...** prompt, select near the lower end of the vertical curve.

6 In the **Match Curve** dialog box, under **Continuity**, click **Tangency**, under **Preserve other end**, click **Position**, and click **Join**.

7 Repeat steps 3 through 6 for the other end of the helix.

**Create the speaker wire**

1 Select the extended helical curve.

2 From the **Solid** menu, click **Pipe**.

3 At the **Starting radius...** prompt, type **.2** and press **Enter**.

4 At the **End radius...** prompt, press **Enter**.

5 At the **Point for next radius** prompt, press **Enter**.
6 Select the curve at the top left.
7 From the **Solid** menu, click **Pipe**.
8 At the **Starting radius...** prompt, type **0.1** and press **Enter**.
9 At the **End radius...** prompt, press **Enter**.
10 At the **Point for next radius** prompt, press **Enter**.

**Mirror the Headphone Parts**

To create the parts for the other side of the headphones, mirror the parts you have already created.

**Reset the layers and view**
1 On the status bar, click the **Layer** pane.
2 Turn on all layers.
3 From the **View** menu, click **Zoom**, and then click **Zoom Extents All**.

**Delete all the shape curves**
1 Press **Esc** to deselect everything.
2 From the **Edit** menu, click **Select Objects**, and then click **Curves**.
3 Press the **Delete** key.

**Mirror the left half of the headphones**
1 In the **Front** viewport, window select the objects as illustrated.
   (Select the speaker, bracket, small wire, and rotated ellipse.)

2 From the **Transform** menu, click **Mirror**.
   The **Mirror** command depends on which viewport is active. It uses the construction plane in the active viewport to define the mirror plane. The mirror plane is perpendicular to the construction plane. Two points define the line in this plane about which the selected objects are mirrored.
3 At the **Start of mirror plane** prompt, type **0,0**.
   This is the first point of the mirror line.
4 At the End of mirror plane prompt, turn on Ortho, and drag the mirror line straight up and pick.

Complete the headphone model
- Add materials to the headphones and render.
Tutorial: Point Editing and Blend Surfaces

This tutorial demonstrates point-editing techniques including moving and scaling control points and adding knots to surfaces to increase control. In addition, you will use blends to create smooth transitions between surfaces.

You will learn how to:

- Rebuild surfaces to add additional control points.
- Insert knots in a surface to add control points in a specific location.
- Edit surface control points to define a shape.
- Scale control points to change the object shape.
- Use object snaps projected to the construction plane.
- Orient an object on a surface.
- Create smooth blends between surfaces.

If you have not completed the Rubber Duck tutorial in the online Rhino Getting Started, try it first. To view the online tutorial, from the Rhino Help menu table of contents, click Getting Started.

Create the Body and Head

If you like, open the example model, Penguin.3dm, and try to match the shapes as you are building the model. Experiment with your own shapes, too.

The body and head are created from one sphere. The shape is formed by moving the control points in the sphere to create the head.

Create the body

1. In the Top viewport, use the Sphere command to draw a sphere with a radius of 10 units.

2. Use the Rebuild command to add more control points to the sphere.
   In the Rebuild Surface dialog box, set the Point count in the U and V directions to 8 and the Degree in the U and V directions to 3.
   Check Delete input.
   Click OK.
3 Use the PointsOn command to turn on the sphere’s control points. Look in all the viewports at the structure of the control points.
The next step will change this structure so the influence of moving the control points does not extend over the whole sphere.

4 Use the InsertKnot command to insert two knots in the sphere in the area where you want the neck.
Insert the knots in the u-direction only as illustrated.

5 Examine the control point structure after inserting the knot.

6 Reposition control points to create the indentation for the neck and to reform the body shape.
You might try the following operations:

7 Use the SetPt command to create a flat bottom. In the Front viewport, select all the control points in the lowest rows of the sphere and set them to match the bottom pole point in the world z-direction only.
In the Set Points dialog box, check Set Z, clear the Set X and Set Y checkboxes, and click World.
Drag the selected control points up.
This will align all of the selected control points to the same z-value (up in Front viewport), flattening the surface.

8 Select rows of control points with a window and drag them up or down in the Front viewport.

Use WireFrameViewport mode if you find it easier to select control points in wireframe views.

9 Select rows of control points with a window in the Front viewport. In the Top viewport, use the Scale2D command to move them closer or farther away from the central point.

To pick the base point for the Scale2D command use the Point object snap with Project turned on. This will scale the points parallel to the construction plane. Watch the Front viewport to see the changes in the body shape as you move the control points closer to and farther from the center.
Experiment with the **Project** setting in the **Osnap** toolbar to see how it works. You will be able to see the tracking line projected to the construction plane in the viewports.
Match the example model or use your own shape.

10 Move individual groups of control points to make the body slightly flatter in the front near the neck as illustrated.

**Create and Place the Eyes**
The eye is an ellipsoid shape that is oriented onto the surface.

**Create the eye**

1 In the **Top** viewport, start the **Ellipsoid** command.
   Place the center point anywhere.

2 At the **End of first axis** prompt, type **1.1** to constrain the distance from the center point to the end of the axis to 1.1 units.
   Drag the cursor to the right and pick.

3 At the **End of second axis** prompt, type **1.1** to constrain the distance.
   Using these constraints has created a circular ellipsoid when seen from the top.
   Drag the cursor up or down in the **Top** viewport and pick.
4 At the **End of third axis** prompt, type .5, press **Enter**.

---

**Move the eye onto the surface**

1 Select the eye ellipsoid in the **Top** or **Perspective** viewport.

2 Start the **OrientOnSrf** command.

3 At the **Reference point 1** prompt, in the **Top** viewport, pick the center of the ellipsoid.

4 At the **Reference point 2** prompt, pick any point to the right or left of the eye ellipsoid.
   
   The exact location is not important.

5 At the **Surface to orient on** prompt, select the penguin body/head.

6 In the **Orient on Surface** dialog box, uncheck the **Copy objects** option, click **OK**.

7 At the **Point on surface to orient to...** prompt, move the cursor onto the head to where you want to place the eye and click.

8 Use the **Mirror** command in the **Front** viewport to create the second eye.

---

**Create the Beak**

The beak is another ellipsoid that you can edit to change the shape.
Create the beak shape

1. In the **Top** viewport, start the **Ellipsoid** command.
   Place the center point anywhere.

2. At the **End of first axis** prompt, type 3 to constrain the distance from the center point to the end of the axis to three units.
   Drag the cursor to the right and pick.

3. At the **End of second axis** prompt, type 2 to constrain the distance.
   Using these constraints creates a circular ellipsoid when seen from the top.
   Drag the cursor up or down in the **Top** viewport and pick.

4. At the **End of third axis** prompt, type 1, press **Enter**.

5. Turn on the control points (**F10**).
   In the **Front** viewport, select the lower row of points and drag them down.
6. Select the row of points in the top center and drag them down to shape the beak. Try using the Nudge keys (Alt + Arrow direction keys) to nudge the selected points.

7. Move the beak into position.

Create the Feet
The feet are created using another ellipsoid. Knots are added to help create the webbed toes.

Draw the beginning ellipsoid
1. In the Front viewport, start the Ellipsoid command. Place the center point anywhere.
2. At the End of first axis prompt, type 1 to constrain the distance from the center point to the end of the axis to one unit. Drag the cursor up and pick.
3. At the End of second axis prompt, type 3 to constrain the distance. In the Top viewport, drag the cursor up and pick.
4. At the End of third axis prompt, type 3, press Enter.

5. Use the Rebuild command to add more control points to the ellipsoid. In the Rebuild Surface dialog box, set the Point count in the U and V directions to 8 and the Degree in the U and V directions to 3. Check Delete input. Click OK.
Create the webbed feet

1. Insert four knots in the ellipsoid as illustrated.

   Set the Symmetrical=On. Insert the knots in the V-direction.

2. Select control points as illustrated.

   Use window and crossing selections to select the control points on both the top and bottom of the ellipsoid.
3 Use the **Scale2D** command to scale the control points out from the center of the foot.

Use the **Point** object snap to set the base point of the scale to the center point of the ellipsoid.

Drag the points to make the whole foot about twice the size of the original ellipsoid.

**Position the feet**

1 Use the **Move** command to move the foot under the penguin body.

2 Use the **Rotate** command to rotate the foot out slightly.

3 Use the **Mirror** command to create the second foot.

**Flatten the bottoms of the feet**

To finish the feet, create a plane through the feet and use a Boolean intersection to trim the feet, the plane, and join the surfaces in one step.

1 Select the feet.

2 In the **Front** viewport, use the **CutPlane** command to make a planar surface that passes through the feet as illustrated.
The **CutPlane** command makes a plane that passes through the selected surfaces along the line you draw.

3  Select the plane and the feet.
4  Start the **Boolean2Objects** command.
5  Click through the preview options until the result is the flat feet as illustrated, and press **Enter**.

---

**Create the Tail**
The tail is another ellipsoid. It is joined to the body with a smooth blend surface.

**Create the tail shape**

1  Draw an **Ellipsoid** that is 4 units long, 3 units wide (**Top** viewport), and 1.5 units tall (**Front** viewport).

2  Use the **Rotate** and **Move** commands to place the tail in position.

---

**Attach the tail to the body with a smooth blend**

1  Use the **BooleanUnion** command to trim and join the tail and the body shapes. The transition between the tail and body is rather abrupt; so replace this with a smooth blend surface.
To do this, you must first create a gap between the two parts for the blend surface to fill.

2 Use the Pipe command to create a circular surface around the edge between the body and tail.
   At the Select curve to create pipe around prompt, select the edge between the tail and the body.
   At the Radius for closed pipe prompt, type .4.

3 Use the BooleanDifference command to trim both the body and the tail surfaces inside the pipe.
   Use the DeleteInput option to delete the original surfaces.

4 At the Select first set of surfaces... prompt, select the body/tail and press Enter.

5 At the Select second set of surfaces... prompt, select the pipe surface and press Enter.

6 Use the Explode command to separate the parts.

7 Delete the part of the pipe remaining between the body and tail.

8 Use the BlendSrf command to create a smooth surface between the tail and the body.
Create the Wings
The wing is another ellipsoid shape. Use control point editing to make the wing shape. Start the ellipsoid in the Top viewport.

Create the wing shape
1. Draw an Ellipsoid that is 2 units long, 2 units wide (Top viewport), and 6.5 units tall (Front viewport).

2. Use the Rebuild command to add more control points to the ellipsoid.
   In the Rebuild Surface dialog box, set the Point count in the U and V directions to 8 and the Degree in the U and V directions to 3.
   Check Delete input.
   Click OK.

3. Drag control points to create the shape.

4. Use the Bend command in the Front viewport to bend the top of the wing shape toward the body.
   At the Start of spine prompt, in the Front viewport, pick near the bottom of the wing.
   At the End of spine prompt, pick near the top of the wing.
   At the Point to bend through... prompt, drag the top of the wing toward the body.
5 If further positioning is needed, use the **Rotate** and **Move** commands to place the wing.

6 Use the **Mirror** command to create the opposite wing.

---

**Attach the wings to the body with a smooth blend**

To create the gap between the wings and body to fill with a blend surface, try a slightly different approach from the tail. Create the pipe and trim the surfaces inside the pipe.

1 To trim the wing hole and the wing, select both wings and the body and use the **BooleanUnion** command.

2 Use the **Explode** command to separate the parts.

3 Use the **Pipe** command to create a circular surface around the edge between the body and each wing.

   At the **Select curve to create pipe around** prompt, select the edge of the hole in the body or the edge of the wing surface.

   At the **Radius for closed pipe** prompt, use a radius of about .6.
4 Use the **Trim** command to trim the body and wing surfaces inside the pipe surfaces.

5 **Delete** the pipe surfaces.

6 Use the **BlendSrf** command to create a smooth surface between each wing and the body.

7 **Join** the blends and wings to the body.

---

**Finishing Touches**

To finish the penguin, split the front part of the body so a different material can be applied to it.

**Separate the front part of the body**

1 In the **Right** viewport, draw a curve from the beak down to the bottom as illustrated.

2 Use the **Split** command to split the body surface with the curve.

3 Use the **Join** command to join the body (except the front), the tail, and the wings.
Apply Render Materials
Rendering creates a “realistic” picture of your model with colors you assign. These render colors are different from the layer colors you might be using, which control the display in wireframe mode.

**Render the penguin**
1. Select the body.
2. Start the *Properties* command.
3. In the *Properties* window, from the list, select *Material*.
4. Under *Assign by*, click *Basic*.
5. Click the color bar.
6. In the *Select Color* dialog box, select a color for the body.
7. Set the *Gloss finish* to about 40.
8. Select the other parts and apply materials in the same way.
9. Use the *RenderedViewport* command to set the viewport rendered mode.
Tutorial: Loft a Boat Hull

This tutorial demonstrates classic boat hull lofting techniques using typical plan and profile curves. The classic hull shape is based on a design from an old *Boat Builder's Handbook* magazine. Many designs similar to this are available over the Internet.

You will learn how to:
- Create 3-D curves from a 2-D lines drawing.
- Rebuild and simplify the curves.
- Use analytical techniques to ensure fairness.
- Loft surfaces from the curves.

Rhino is used by marine designers in many segments of the industry. For more tutorials and information about marine design, see the Rhino Web site at www.rhino3d.com.

Marine Terms Used in this Tutorial

**Sheer**
The fore-and-aft curvature from the bow to the stern of a ship's deck as shown in side elevation.

**Chine**
The intersection of the bottom and the sides of a flat or v-bottomed boat.

**Transom**
The planking forming the stern of a square-ended boat.

**Fair**
The meaning of "fair" is much debated in the marine industry. No one can define it, but they know when they see it. Although fairing a surface is traditionally associated with hull surfaces, all visible surfaces on any object can benefit from this process. In Rhino, the first cue for fairness in a surface is the spacing of the surface display isocurves.

There are other characteristics of fair curves and surfaces. Although a curve or surface may be fair without exhibiting all of the characteristics, they tend to have these characteristics. If you keep these in mind while modeling, you will end up with a better final product.

The guidelines for creating a fair surface include:
- Use the fewest possible control points to get the curve shape.
- Use the fewest possible curves to get the surface shape.

Lay Out the Hull Curves

The hull lines were created by tracing the original plans using a background bitmap. The first step is to check the lines for fairness before creating surfaces from them.
The designer’s lines are illustrated. The sheer and chine have been extended at the forward and aft ends to accommodate the lofting process.

Start the Model
1. On the Rhino Help menu, click Learn Rhino, and then click Open Tutorial Models.
2. Open the model file Victory.3dm.
   The lines are laid out on the Plan layer and the Profile layer.

Check for Fairness
Select each of the designer’s curve pairs in plan and profile and use the CurvatureGraphOn command to determine if the curves are “fair.” In this case, the file has the original curves that were traced from the background bitmap. They are not “fair.” In other words, the curves do not smoothly transition from one end of the sheer to the other. If any curve is not fair, adjust points to make it fair. Start with the sheer (the curve at the top of the hull shape). It has the biggest impact on the appearance of the vessel.

The illustration shows the curvature graph applied to the two-dimensional sheer in profile.

Check the curves for fairness
1. Select the curves you want to check.
2. Use the CurvatureGraphOn command to display its curvature graph.

The curvature graph should be continuous and exhibit the characteristics desired for the curve. When the curve is concave downward, the graph will be above the curve. Conversely, concave upward curves will have their graphs below them. The point of inflection (where the curve is neither concave upward nor downward) is indicated where the graph crosses the curve.

Rebuild the Curves
Before doing any point editing to make the curves fair, rebuild the curves to remove excess control points.
Select each curve and use the Rebuild command to reduce the number of points and set the degree. Do not use more points than you absolutely need.
Use the CurvatureGraphOn command to check the curves again for fairness. If the curvature graph is still not satisfactory, move the control points until you have a smooth graph. Proceed with the rest of the curves in the model to be certain they are fair before beginning to surface the model.

**Rebuild the curves**

1. Select the sheer curve.
2. Start the Rebuild command.
3. In the Rebuild Curve dialog box, change the Point count to 6 and the Degree to 5.

**Create the 3-D Curves**

So far, you have been working with two-dimensional curves. In order to loft the surfaces, these planar curves will be used to create to three-dimensional curves and the planar curves can be discarded.

With the 3D Lines layer current, select the profile and plan view representations of each curve. Use the Crv2View command to create the three-dimensional curve that combines the x-, y-, and z-coordinates of the two-dimensional curves. The two-dimensional curves must be planar for this command to work.

**Create the three-dimensional curves**

1. Set the 3D Lines layer current.
2. Select the plan and profile representations of the sheer curve.
3. Start the Crv2View command.
   The three-dimensional representation of that curve will be created.
4 When you are satisfied that the proper curve was created, delete or Hide the two-dimensional representations.

5 Repeat the Crv2View command for the chine curve.

About the Curves
For the loft process to work on the bottom panel, it cannot come to a point. The lofted shape must be rectangular. This is why the curves are extended beyond the centerline. The curves can be lofted into a rectangular surface that can then be trimmed back. The curves in the Victory model are already extended for you except for the bottom centerline curve.

Create the extended curve

1 Start the Curve command.

2 Use the Near object snap to place the first three control points along the centerline.

3 Draw the curve so it aligns nicely with the chine and sheer curves in the plan view as illustrated.

4 Split the centerline curve with the curve extension and Join the curve extension to the aft part of the split centerline. This creates a new bottom curve to use for the surface loft.

Loft the Hull Surfaces
Now that you have created a set of edge curves for the side and bottom, create lofted surfaces from these curves. Start by lofting the bottom surface. Once you have finished it, use its upper edge as the curve from which to loft the side panel.

To loft the bottom panel, select the two edges (chine and centerline) and use the Loft command. In this case, be sure to select the new centerline you created in the previous step.
Loft the side and bottom and the chine and centerline

1. Select the chine and 2-D centerline. Start the **Loft** command.

2. In the **Loft Options** dialog box, under **Cross-section curve options**, select **Rebuild with...**, and set the control point count to **15**, click **OK**.

3. Repeat the **Loft** for the side panel, selecting the surface edge and the sheer curve. Loft with the same settings in the **Loft Options** dialog.

Trim the Bow and Bottom

When you have successfully created both the side and bottom surfaces, construct a buttock one-half inch off the centerline and trim both surfaces to this buttock. To do this, in the **Top** viewport, draw a line longer than the hull and one-half inch to the right of centerline.

**Draw the trim line**

1. In the **Top** viewport, draw a **Line** along the x-axis that is longer than the hull.

2. In the **Top** viewport, offset the line 1/2” toward to hull surfaces.

**Trim the side and bottom to the trim line**

- Use the **Trim** command to trim the side and bottom as illustrated.
Build the Transom

Like all surfaces in this tutorial, the transom will be built with a surface larger than the finished surface and then trimmed to the hull.

To make sure there is enough surface area to trim, Extend the transom centerline by a foot or two both above the sheer and below the centerline. Trim the hull surfaces with the transom centerline.

Extend the centerline

1. Start the **Extend** command.
2. At the **Select boundary objects or enter extension length. Press Enter for dynamic extend** prompt, press **Enter**.
3. **Select curve to extend...** prompt, in the **Front** viewport, select near the top of the transom centerline.
4. At the **End of extension** prompt, select a point above the current top of the transom centerline.
5. At the next **Select curve to extend...** prompt, select near the bottom of the transom centerline.
6. At the **End of extension** prompt, select a point below the current bottom of the transom centerline, press **Enter**.

Trim the hull surfaces

1. Select the transom centerline.
2. Start the **Trim** command.
3. In the **Front** viewport, at the **Select object to trim...** prompt, select the hull side and bottom surfaces aft of the transom centerline. Set **UseApparentIntersections=Yes**.

Mirror the Hull and Create the Keel Surface

In the **Right** or **Top** viewport, Mirror the two hull surfaces about the centerline. Use the **EdgeSrf** command to create surfaces between the two hull halves.
Mirror the hull surfaces
1. Select the two hull surfaces.
2. Start the Mirror command.
3. In the Top viewport, at the Start of mirror plane... prompt, type 0, press Enter.
4. At the End of mirror plane prompt, with Ortho on, drag the mirror plane along the x-axis, and click.

Create the keel surface
1. Start the EdgeSrf command.
2. At the Select 2, 3, or 4 curves prompt, select the two inner edges of the hull bottom along the keel.
3. Repeat the EdgeSrf command.
4. At the Select 2, 3, or 4 curves prompt, select the two inner edges of the hull sides along the keel.

Extrude the Transom Surface
To create the transom surface, Extrude the transom centerline.

Extrude the surface
1. In the Front viewport, select the extended transom centerline.
2. Start the ExtrudeCrv command.
3. At the Extrusion distance prompt, set BothSides=Yes and Mode=Straight.
   In the Perspective viewport, drag the extension beyond the hull surface.
**Trim the Transom**

**Trim** the transom surface with the hull and a line from the hull edges.

**Trim the transom**

1. Draw a line between the two hull edges.
2. Start the **Trim** command.
3. At the **Select cutting objects** prompt, select all of the hull surfaces, including the keel surface and the line at the top of the hull, press **Enter**.
4. At the **Select object to trim...** prompt, select the transom surface outside of the hull lines, press **Enter**.

**Complete the Transom**

The transom is now complete. **Join** the all surfaces. Use the **ShowEdges** command to check that the join was successful. Display the **naked** edges. Naked edges are surface edges that are not joined to other surfaces. In this case, the only naked edges should be the ones you expect around the outside of the hull surfaces – not those between the surfaces.

When you have your surfaces built and joined, and have no unjoined edges, look at the surface with the curvature analysis tools.

**Add the Deck**

The last step is to create the deck surface. In the profile lines, two curves describe the silhouette of the deck curve. You will use this curve to create the deck.
Draw the Cross-section Curve for the Deck Surface
Use the Project command to project the vertical line to the side of the hull. This line will act as a marker for the end of the curve. In the Front viewport, draw a curve from the end of the deck centerline curve to the end of the projected curve on one side of the hull. Use Planar mode to keep the curve planar. Place the first three control points using Ortho to keep them lined up at the center.

Project the vertical deck edge to the hull
1. Select the hull and the vertical line.
2. In the Front viewport, use the Project command to project the curve to the hull.
   The curve will project to both sides of the hull, so you can draw your cross-section curve on either side.

Draw the cross-section curve
1. Click the Planar pane in the status bar to turn on Planar mode.
2. In the Front viewport, use the Curve command to draw a control point curve from the top end of the deck centerline curve to the top of the curve projected to the hull.
   Use Ortho to place the first three control points in a straight line.

   Use the End object snap to place the last point at the top of the projected curve on the hull.
Create the deck surface

1. Use the **Sweep2** command to create the deck surface.

2. At the **Select rail curves** prompts, select the centerline curve and the hull edge.

3. At the **Select cross section curves**... prompt, select the cross-section curve you created from the deck centerline curve to the projected curve on the hull, press **Enter**

4. Use the **Mirror** command to copy the deck surface to the other side.
   
   At the **Start of mirror plane**... prompt, in the **Top** viewport, type **0**, press **Enter**.

5. At the **End of mirror plane**... prompt, in the **Top** viewport, drag the mirror plane with **Ortho** on.

6. Use the **EdgeSrf** command to create the small triangular surface at the tip of the bow.

7. **Join** all the surfaces.
Tutorial: Trace Images

This tutorial demonstrates how to get started modeling an object using photographs as reference material.

You will learn how to:

- Trace an image to create profile curves.
- Create cross-section curves for lofting the profiles.
- Edit control points to change a surface shape.

Note

The top and side views are actually of different specimens of this dragonfly. In the side view, the wings are folded up. We will be using the side view image only to draw the side view curves of the body.

Draw the Body

Since the dragonfly is symmetrical in the top view, and the model is not going to be a scientific reproduction, trace one side of the dragonfly and mirror the curve to the other side. For the side view, draw two curves since the profile is not symmetrical. Then we will loft cross section curves to make the body. The head will be made separately.

The tail and body will all be made in one piece. The tail is actually several segments that flex. If you were making an animation or a scientific model, you probably would want to divide the dragonfly into smaller surfaces.

The background bitmap images can be displayed in either color or grayscale.
Set up the images

1. Use the Line command to draw a reference line the length you want the dragonfly to be. Use grid snap or enter a distance to control the length of the line.

2. In Windows Explorer, navigate to the folder where the tutorial models are stored.

   To find this folder, on the Rhino Help menu, click Learn Rhino, and then click Open Tutorial Models.

   In the tutorial folder, you will find the two images you need for this exercise. Copy these images to a convenient folder.

3. Start the BackgroundBitmap command with the Place option.

4. Open the image file DragonFly Top.jpg.

   Place the image in the Top viewport.

5. Repeat the BackgroundBitmap command for the side-view.

   Place the side-view image in the Front viewport.

6. With the BackgroundBitmap command Align option, place the images so the reference line runs through the center of the image in both views.

Draw the outline curve

1. Use the Curve command to draw a plan view outline of the dragonfly.

   Draw only up to the neck. You will be creating the head another way.

   In the Top viewport, you can trace one side and then use the Mirror command to copy the curve around the reference line.

   The photograph shows that the dragonfly is not symmetrical about its centerline. However, your dragonfly will be somewhat stylized to make drawing it easier.
2 In the **Front** viewport, use the **Bend** command to bend the curves down at the tail to match the bend in the body curve in that view.

3 In the **Front** viewport, trace the body outline using two curves, one above the reference line and one below the reference line. Maximize the viewport and zoom in. Pick only as many points as you need to create the curves. Use more points when rounding a corner and fewer points for a straight section.

**Create the body surface**

1 Use the **CSec** command to create cross-section profile curves through the top, bottom, and side curves. Draw only as many cross-section curves as you need to maintain the detail. You will be able to see whether you have enough curves when you loft the surface in the next step. If you do not have enough curves to maintain the shape in an area, you can add more and retry the surface loft.

2 Select all the cross-section curves you just created.

3 Use the **Loft** command to create a surface through the cross-section profiles.
Draw the Head
Draw the head with an ellipsoid and move the control points around to deform the head. The eyes are also ellipsoids. The neck is a surface blend.

**Draw the head**

1. Use the **Ellipsoid** command to draw the head shape.
   Use the **Diameter** option and start the ellipsoid in the **Front** viewport to approximate the head shape.

   ![Ellipsoid command](image1.png)

   ![Approximate head shape](image2.png)

2. Use the **Rebuild** command to add more control points to the ellipsoid.
   Set the point count to **16** in the u-direction and **10** in the v-direction.

   ![Rebuild command](image3.png)

   ![Add control points](image4.png)
3 Use the **PointsOn** command to turn on control points for the ellipsoid.

4 In the **Top** viewport, select and drag points on both sides of the ellipsoid toward the back to deform the head.

5 In the **Right** viewport, drag the middle two rows of points down.

**Blend the Head and Body**

The neck is a blend surface between the head shape and the body. First, you are going to trim the head shape to make an opening.

**Draw the neck**

1 In the **Front** viewport, draw a line as illustrated and use the **Trim** the head shape with the line.
2 Use the **BlendSrf** command to make a blend surface between the head and body. Be sure the seams are aligned and the direction arrows point the same way.

---

**Draw the Eyes**
The eyes are simple ellipsoids.

**Draw the eyes**

1 Use the **Ellipsoid** command to draw the eye. Base the size and position on the bitmap background.

2 Use the **Move** and **Rotate** commands to adjust the position of the eye.

3 Use the **Mirror** command to copy the eye to the other side.
Shape the Tail
The end of the tail has a rounded shape cut out of it. Use a Boolean to make this shape.

Cut the tail
1. If necessary, extend the tail section by turning on the control points and dragging them to match the bitmap.
2. Use the Cap command to make the body into a solid.
3. Use the Cylinder command to draw a solid cylinder so it cuts through the tail as illustrated.
4. Use the BooleanDifference command to cut the end out of the tail.

Trace the Wings and Legs
The wings are solids created from closed curves. The legs are created by tracing a polyline down the center of a leg and using a pipe surface to make a series of tubes around the polyline.

Draw the wings
1. In the Top viewport, use the Curve command to trace the wings on one side of the dragonfly.
2. Make the curves into thin solids with the ExtrudeCrv command. Use the Cap=Yes and BothSides=Yes options.
3. Position the wings on the back with the Move command. Consult the side view image of the dragonfly. The front wing is slightly higher than the back wing.
4. Use the Mirror command to copy the wings to the other side.
**Draw the legs**

1. In the **Top** viewport, use the **Polyline** command to trace down the center of the legs.

2. Edit the control points to position the legs in the **Top** and **Front** viewports. You will have to use your imagination a little for this since the two pictures do not show the legs of the same insect.

3. Use the **Pipe** command to draw the legs around the polylines. Refer to the background picture to determine the starting and ending diameter of the pipe.

4. Use the **Mirror** command to copy the legs to the other side, or draw different legs for the other side.

**Finish the Model**

- Add colors and textures and render.
Tutorial: Wrap Curves on a Surface

This tutorial demonstrates wrapping text solids and other objects on a cylinder. These objects could be used to trim holes in the cylinder.

You will learn how to:
- Create text as solid objects.
- Wrap the objects to a surface.

Make a Surface

For this example, create a simple cylinder. Once you have learned the basic technique, you will be able to use other types of surfaces. Remember that trimmed surfaces maintain their basic rectangular shape. This underlying shape will affect the placement of the text.

Create a cylinder

1. In the Top viewport, use the Cylinder command with the Vertical option to create a solid cylinder.

2. (Optional) Use the Explode command to separate the cylinder into three surfaces and Delete the top and bottom of the cylinder.
Create the Objects to Wrap
These solid objects will be wrapped on the cylinder surface.

Create the text

1. Use the **TextObject** command to create your text using **Solids**.
   Choose a font that is fairly large and blocky rather than one with many details.
   Set the **Height** at about **1.5** units.
   Set the **Solid thickness** to **.1** units.

2. Place the text on the construction plane near the cylinder. The location is not important.

Control the Placement of the Objects
The **CreateUVCrv** command generates the planar border curves of a surface that can be used as a guide to orient your text. Use the border rectangle to lay your text out before re-applying it to the cylinder. The rectangle then is used as a reference to guide the placement of the other objects.

Fine-tune the size and placement

1. Select the cylinder and use the **CreateUVCrv** command to create curves that represent the border of the untrimmed surface on the construction plane. In this case a rectangle is created starting at 0,0 on the **Top** construction plane.
2 Select the cylinder and use the **Properties** command to turn off the isocurve display on the cylinder. This will show you where the seam of the surface is located. The seam location is important because the rectangle edges match the top and bottom of the cylinder and the seam. Knowing where the seam is will help you visualize how the text will be laid out on the cylinder.

In our example the cylinder is rotated so the seam is toward the back in the view.

3 **Move**, **Rotate**, and **Scale** the text to arrange it inside the rectangle. Add any other decoration curves you want to use.

4 Use the **PlanarSrf** command to make the rectangle into a surface. You will use this surface later as a reference object.

**Extrude the decoration curves**

1 If you have created other curves, select these.
2 Use the **ExtrudeCrv** command to thicken the decorations to match the letters.
3 At the **Extrusion Distance**... prompt, set **Cap=Yes**.
4 At the **Extrusion distance**... prompt, type .1.

**Wrap the lettering on the cylinder**

1 Select the lettering and the decoration.
2 Start the **FlowAlongSrf** command.
3 At the **Base surface**... prompt, set **Rigid=No**.
4 Click the **rectangular plane** near the "lower-left" corner as illustrated.
5 At the **Target surface**... prompt, click the cylinder near the lower edge of the seam as illustrated.

The text solids wrap around the cylinder.
Tutorial: Blends and Trims

At first glance, this camera model looks complex. But after a little analysis, you’ll see that it’s made of a three basic blocks, glued together liberally with blends. The three basic blocks are the body, the viewfinder, and the lens housing.

The primary tool used to make this model is the BlendSrf command. It creates smooth, curvature-continuous blends between two or more surfaces. This demonstration shows several ways of creating surfaces (and more importantly the gaps between surfaces) that are amenable to blending.

**The creation of the model can be broken into seven steps:**

1. Create basic body shape.

2. Blend the front and back edges.
3 Trim a hole in the body for the viewfinder.

4 Create the viewfinder surface.

5 Blend between the body and the viewfinder.

6 Boolean bottom surface and blend bottom edge.

7 Create lens and blend to body.
Start the Model

1. On the Rhino Help menu, click Learn Rhino, and then click Open Tutorial Models.
2. Open the model file Camera.3dm.

The model is organized into layers that follow the steps. You can open this model and follow along with the instructions by turning the layers on and off.

Almost every stage involves the creation of a surface that will later be blended to create the smooth, organic model shown above.

Create Basic Body Shape

The basic body shape is made of three trimmed surfaces. All three are made with extrude commands. The first step in creating these surfaces is to create the curves that define them.

Create profile curves for front and back surfaces

Both the front and back surfaces have a slight curve. The back surface curves in one direction, and is most easily made using the ExtrudeCrv command to extrude a curve. The front surface is curved in two directions, so it is made by extruding one curve along another.

1. In the Top viewport, use the Curve command to draw curves 1 and 2.
   Use the minimum number of control points necessary to create the shape. Keeping control points to a minimum keeps file sizes smaller, makes surfaces smoother, and makes future modeling tasks faster and easier. Notice that the control points are symmetrical. This ensures that the curve is symmetrical. In addition, the middle three control points are lined up parallel to the x-axis. This makes a nice smooth, flat curve that is exactly tangent to the x-axis.

2. Draw curve 3 in the Right viewport.
   Start it at the endpoint of curve 2 and use Planar mode to keep the curve lined up.
**Extrude the front and back surfaces**

1. To create the back surface, use the `ExtrudeCrv` command to extrude curve 1 in the z-direction. Estimate the height. Make sure it is taller than curve 3. The height is not important, since the top will be trimmed off with the side surface.

2. To make the front surface, use the `ExtrudeCrv` command to extrude curve 2 along curve 3.

**Create profile curve for side surface**

- With the `Curve` command, create a profile curve for the side surface. Create this curve in the Front viewport. Be careful to make the curve start and end exactly at the edge of the surface. If the curve stops short, or extends beyond the bottom of the existing surfaces, the trim used in the next step will fail.

**Extrude the side surface**

- With the `ExtrudeCrv` command, extrude the profile curve toward the back. Make sure it fully intersects both the front and back surfaces. An incomplete intersection will make the trims in the next step fail.
**Trim and join the surfaces**

Trim the three surfaces.

1. Use the **Trim** command to trim the front and back surfaces with the extruded side surface.

![Image of trimmed surfaces](image1)

2. Use the **Trim** command to trim the side surface with the front and back surfaces.

![Image of trimmed side surface](image2)

**Blend the Front and Back Edges**

A blend surface matches smoothly (the blend surface has curvature continuity along the edges shared with the other surfaces) between two or more surface edges. Blend surfaces were used for both the front and back edges of the camera body. Two techniques for trimming the surfaces to open up a gap for blending are shown in this step.

**Trim the front surface**

The most straightforward and flexible method to create a gap for the first blend is to trim each surface with curves. This method allows the blend surface to vary in width at different points along the blend.

1. **Hide** the back and side surfaces.

![Image showing hidden surfaces](image3)
2 In the Front viewport, use the Curve command to draw a profile curve.

3 Use the Trim command to trim the surface with the profile curve.

Trim the side surface

1 Use ShowSelected command to unhide the side surface.

2 In the Right viewport, use the Curve command to draw a profile curve.
   This curve is planar and lies on the construction plane in the Right viewport.

3 With the Trim command, trim the side surface with the profile curve.

Blend between front and side surfaces

There are several options for creating blend surfaces. It is easiest to start with the defaults and see if the result is to your liking. The following illustrations show the results of using the default option.
1 Use the **BlendSrf** command to create a surface between the front and side surfaces.
If you simply allow the surface to be created from the defaults, the corners will be rather square and the way the surface travels around the bends is not very smooth.

2 To improve this, delete the original blend and make a new blend.
The **BlendSrf** command lets you control the cross-sections of the blend. In this case set the bulge height to around .7 and then place cross section curves along the opening to control how the surface will move around the curves.

When Rhino creates a blend, it creates a series of sections between the two surfaces to blend. These sections flow smoothly from one surface to the other. The number of sections you need depends on the complexity of the blend—use more cross-sections for more complex blends.

**Blending the back edge**
Another approach for creating a gap to blend is to create a fillet surface. A fillet surface has a constant radius. In the process of creating the fillet surface, both surfaces that are being filleted are trimmed with the new surface. You can then delete the fillet and replace it with a blend. You can also create a variable width blend surface with this method, but it is not as flexible as the previous technique.

1 Use the **FilletSrf** command to create a rolling ball fillet surface between the back surface and the side surface. Use the **Trim=Yes** option and a radius of **0.7**.
2 Delete the fillet surface.

3 Use the BlendSrf command to create a blend surface in place of the fillet surface.
   Place extra cross-sections around the corners.

   The results may look almost identical in these pictures – and they are, almost – but when the model is shaded and rotated, the blend surface matches the back and side surfaces more smoothly because of the curvature continuity of the blend. Fillets are only tangent to the surfaces, blends are curvature continuous. Try it yourself to see the difference.

4 Use the Join command to join all the surfaces together into a polysurface.

Trim the Body for the Viewfinder

The viewfinder bulges out of the body. This bulge houses the viewfinder window and the necessary optical components that let you look through the camera. As with the rest of the camera, the viewfinder should blend in smoothly with the rest of the body.

The blend is made with the same approach used to create the front surface blend: trim both parts and create a blend surface between them. Since the camera body is actually a polysurface, and the blend fills a more complex hole, more steps are required to create the blend.

Create body trimming profile curve

The viewfinder will wrap around the top of the body. This means that the hole in the body needs to wrap around the top, too.

1 With the Curve command, draw a rough approximation of the hole the Front viewport. Draw the curve symmetrical about the y-axis.

   Ensure the symmetry by drawing half the curve, mirroring it about the y-axis, and joining the two sides. The last two control points (the ones at the end where the two halves meet) are lined up horizontally to ensure the curve doesn’t have a kink when mirrored.
2 Press **F10** to turn on control points and move them to get the curve to wrap around the surface.

Drag the control points in the **Right** viewport. Turn on **Ortho** so that the control points only drag parallel to the world y-axis.

**Pull the trimming profile curve onto the body surfaces**

Now that the curve wraps around the body polysurface, you will pull the curve back to the surfaces.

You need to pull the curve to each surface separately, resulting in a series of curves.

1 Use the **Pull** command to pull the curve to each surface separately, resulting in a series of curves.

2 Delete extra curves until you have a series of curves around the surfaces that match the original curve as illustrated.
**Split the body parts with the curve**

1. Use the **Split** command to split each surface with the pullback curves.
2. Delete the unnecessary geometry as illustrated.

**Create the Viewfinder**

The next step in creating the viewfinder is to create the main shape of the viewfinder surface. It is a simple extruded surface trimmed to complement the hole in the body.

**Create the viewfinder surface**

1. In the **Right** viewport, use the **Curve** command to draw a profile curve for the viewfinder surface.

2. Use the **ExtrudeCrv** command to extrude the curve in both directions from the center profile.
**Create viewfinder trimming curve**

To create the viewfinder trimming curve, start with the curve that was pulled back to the camera body.

1. Use the **Scale1D** command to scale the curve several times to get the curve roughly the right shape.

Scale the pullback curve vertically in the **Right** viewport.

Scale the pullback curve horizontally in the **Front** viewport.

2. The final shape is achieved with control point editing.
With the **Pull** command, pull the resulting curve back to the surface.

Use the **Trim** command to trim the surface with the curve.

**Blend between the Body and the Viewfinder**

Blending between the body and the viewfinder surface is more difficult than the blends between the front, back and sides because it follows such a complex path.

**To create the blend between the body and viewfinder**

1. Start the **BlendSrf** command.
2. Select all the edges on the body surface (in order), then select all the edges for the viewfinder.
3. Add enough cross sections so that the transitions around the tight turns at the back are smooth.
Create Bottom of Camera

At this point, the bottom of the camera is open. To close it, draw a curve that represents the bottom, extrude it, and use Boolean intersection to trim and join the surfaces.

**Create the bottom surface**

1. In the *Front* viewport, draw a profile curve with the *Curve* command.

2. With the *ExtrudeCrv* command, extrude this profile curve beyond the front and back of the camera.

3. With the *Dir* command, check the direction of the surfaces to ensure the body points out, and the bottom points down.

Use the *Flip* option to correct the direction if necessary.
4 Use the **BooleanIntersection** command to trim and join the two surfaces in one step.

Create bottom edge blend

We have used trimming and filleting to create a gap between surfaces for blending. A third technique for creating a gap for a blend is to create a pipe around the edge, split the surfaces with the pipe, and blend between them. This usually gives a slightly different result than the fillet technique.

1 To create the pipe, with the **ExtractSrf** command, extract the bottom surface from the polysurface.

2 Use the **DupBorder** command to create a single closed border curve. This creates a curve that can be used to create the pipe.

3 With the **Pipe** command, create a pipe surface around the duplicated border. Use a radius of **0.5**.
4. With the **Split** command, trim the body and the bottom with the pipe.
5. Delete the unnecessary pieces, including the pipe.

**Blend surface on bottom surface**

1. With the **BlendSrf** command, create a blend to fill the gap.

2. With the **Join** command, join the parts together.

**Create the Lens and Blend between the Body and the Lens**

The last step is to create the lens and to blend the surface between them.

**Create the lens profile curve**

1. With the **Polyline** command, draw the upper half of lens profile curve.
2. With the **Fillet** command, fillet the polycurve in a few places to round off some of the sharp corners.
3 Use the **Revolve** command to create a revolved surface from the profile curves. Snap to end 1 as illustrated for the beginning of the revolve axis. Use **Ortho** to make the revolve axis parallel to the world y-axis.

**Split body and lens with pipe**

Blend between the body and the lens the same way the bottom edge was blended.

1 With the **Intersect** command, create the intersection curve between the body and the lens surface.

2 With the **Pipe** command, create a pipe surface around the intersection curve with a radius of **0.15**.
3 **Split** the lens and body with the pipe.
4 Delete the pipe and the extra surfaces.

5 With the **BlendSrf** command, fill the gap with a blend surface between body and lens.

6 Set material properties and render.
More Help

The Rhino Help file is the major resource for detailed information on specific commands.

**To get help on a specific command**
- To get Help for a command, press **F1** while the command is running.
- On the Rhino Help menu, click Command Help. The Rhino Help will display in a dockable window.
- Click Auto-Update to display the Help topic for the current command. The Help window appears with the specific command topic visible.

**Help on the Internet**

Find the answers to frequently asked questions at: 
For technical support, send email to: tech@mcneel.com.
Chat with other Rhino users on the Rhino newsgroup at: 
Find tutorials, examples, books, and links about Rhino at: www.rhino3d.com/resources.